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BI Dashboard Builder – ADF Tool
Overview – BI Dashboard Builder

Dashboard in BI Dashboard Builder

BI Dashboard Builder is a powerful business intelligence tool for building custom dashboards with interactive 
charts, gauges, and tables that use real-time data directly from a user’s CMiC system to:

• Consolidate and visualize large amounts of data from departments to provide high-level overviews that 
display current statuses and reveal insights and trends.
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• Provide operational metrics and KPIs to monitor and track performance and progress, and to measure 
the impact of activities and investments.

• Provide real time monitoring of any data in a user’s CMiC system.
• Help make informed and effective decisions.

Since these dashboards use data directly from a user’s CMiC system and are native to it (i.e., use same data 
formats), no data synchronization is required between the dashboards and the user’s system, as would be for 
third-party BI dashboards, which means better performance and always up-to-date data. Furthermore, links to 
created dashboards can be added to Treeviews using our Treeview Builder tool, or to new Enterprise Console 
tabs using our UI Console tool.

BI Springboards
In addition to using BI Dashboard Builder to create display-only dashboards, it can be used to create dashboards 
with link-out capabilities, referred to as BI Springboards.  As shown below, tables provide the ability to 
springboard to record screens to view further details, edit data, and perform actions like replying to RFIs, 
approving requests, changing voucher compliance statuses, and updating equipment details:

For details about a table’s springboard capability, please refer to the following subsection, Tables. 
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BI Query Builder
BI Query Builder is a simplified version of BI Dashboard Builder, tailored specifically for building and 
generating queries. In this specialized version of the software, users can focus on creating and modifying 
queries. In BI Query Builder, a query is a dashboard that contains a single table visualization that is always 
maximized. This fine-tuned query generator makes query building simple and easy, and it supports all the table 
visualization features available in BI Dashboard Builder, including pivoting, drill-in-place, etc. In addition, 
queries built in BI Query Builder can be viewed and maintained in BI Dashboard Builder. 

Requirements
CMiC BI requires an Oracle WebLogic 12c Application server and a valid corresponding Oracle license.

CMiC BI Solution Options
There are two options for implementing our BI solution:

• Have it installed on a user’s own Oracle 12c Application servers.

• Sign up for CMiC’s Cloud based BI solution, which includes the required hardware and Oracle 
license.

Questions or requests should be submitted by creating an issue in CMiC 360.
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Data Sources
Data Sources, Business Areas, Folders, & Fields

BI Catalog Builder, showing a data source, business area, folder and fields

The following section provides details about data sources and their components: business areas, folders, and 
fields.

Data Source (Superset of Database Objects)

A data source is a master set of tables and views that have been logically organized into subsets referred to as 
business areas.

Pop-up window launched when creating a new dashboard in BI Dashboard Builder tool

In BI Dashboard Builder, a data source is selected when creating a new dashboard (as shown above), and its 
folders (i.e., tables/views), and the results (rows) returned by their joins are used to create the dashboard’s 
visualizations (i.e., charts, gauges, tables).

Business Area (Subset of Data Source)

A business area is a subset of the data source that contains a logical grouping of tables/views (i.e., folders) 
pertinent to a dashboard to be created in BI Dashboard Builder.
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Folder (Table/View)

A folder is a single table/view, which contains rows of records comprised of fields (i.e., columns).

Field (Column in Row of Table/View)

For a table’s or view’s row, its data is stored in fields (i.e., columns).

CMiC Default Data Source & BI Catalog Builder
In BI Dashboard Builder, a dashboard is created using a particular data source.

A default data source is provided with BI Dashboard Builder titled, CMiC Default Data Source, which contains 
nearly every table and view in the system, with nearly all the joins that could be required between them 
optimally predefined. To create new dashboards, this provided data source likely contains the required tables, 
views and joins.

If the provided data source, CMiC Default Data Source, is not sufficient to create a desired dashboard, because 
a different join type is required (e.g., Left Outer required instead of Inner) or a required table\view is missing, 
the BI Catalog Builder tool can be used to create the necessary data source. For details about creating a data 
source, please refer to the BI Catalog Builder user guide.
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Getting Started – Creating 
Dashboards
Step 1: CMiC BI Security Set Up

Before BI Dashboard Builder can be used, CMiC BI security must be set up using the follow sections:

1. CMiC BI Security Set Up – Quick Guide

2. CMiC BI Security – BI Dashboard Builder

NOTE: Initial Access to Default Dashboards

BI Dashboard Builder’s File > Open option to load default or custom dashboards

When BI Dashboard Builder is accessed for the first time, none of the provided, default dashboards accessed 
using BI Dashboard Builder’s File > Open option will be available to any user, until they are granted the 
appropriate security access.
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Step 2: Create New Dashboard

Click the File drop-down menu and select “New”. 

In the pop-up, shown below, provide a name for the new dashboard and select the data source containing the 
folders (tables/views) required to create the dashboard’s visualizations:

Upon clicking [OK], the newly created dashboard is displayed:
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Step 3: Add a Visualization

Since the screen will initially be in Edit Mode when a new dashboard is to be created, the Visualizations pane 
will be visible, as shown above, to select a visualization to add to the dashboard.

Click the visualization to add, and it will be added to the dashboard, as shown below. When a visualization is 
added, it is automatically selected (as indicated by its blue header), so the options in the Visualizations and 
Fields panes are applicable to it.

NOTE: A dashboard must not contain more than 20 visualizations.
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Step 4: Add Fields to Visualization

Next, click the up-arrow ( ) in the Fields pane to add fields (tables/views) to the visualization.

For details about adding fields to visualizations, please refer to the following section: Fields – Pane.

Step 5: Configure Visualization Properties

Stacked Column Chart

Next, configure the visualization’s properties using the Visualization Properties control, as shown above. For 
details about configuring a visualization, please refer to the following section: Visualizations.

Step 6 (Optional): Add Page Filter for Visualization(s)
Optionally, add a page filter to filter the visualization. For details about adding page filters, please refer to the 
following section: Insert Filter (Page Filter) – Menu Option.
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Step 7: Assign Security Role(s) to Dashboard
Use the Assign Roles to Dashboards utility to assign the appropriate security role(s) to the new dashboard.

NOTE: Dashboards are only available to users that belong to their assigned security roles. Also, after BI 
Dashboard Builder is installed, security roles must be assigned to the provided dashboards to make them 
accessible to users. Depending on security setup, the administrator’s security role may also need to be assigned 
to the Assign Roles to Dashboards program.

Step 8: Make Dashboard Accessible via Console
Lastly, the new dashboard needs to be made accessible to end-users. For details on how to do this, please refer 
to the following section: Making Dashboards Accessible via Console.



User Reference BI Dashboard Builder - ADF Tool Dashboard Runtime Controls  •  11

Dashboard Runtime Controls
Edit, Show/Hide Properties, Refresh – Controls

Example of dashboard at runtime for end-users, with the Dashboard Runtime Controls framed in red

The following dashboard controls are applicable to end-users at runtime. User must click on the Ellipses icon 

( ) to view complete toolbar.

Edit 
At runtime, this control is available to end-users with the BIDBRDEDIT system privilege in order to edit 
dashboards via BI Dashboard Builder.

Dashboard Settings

Pop-up window launched from Dashboard Settings icon in Dashboard Runtime Controls toolbar
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Current Project Only – Checkbox

If ‘Current Project Only’ box is checked, the dashboard’s visualizations using folders that are current-
project sensitive will only use data from the user’s current default project, as set in CMiC Field (formerly 
xProjects).

This option is applicable to:

1. Visualizations using data from folders of the advanced analytics type that are current-project sensitive 
(i.e., capable of returning data only for user’s current default project). Folders of the advanced 
analytics type are identified in BI Catalog Builder by the “BI” suffix in a folder’s name, as shown 
below:

BI Catalog Builder – Edit Data Sources
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2. Visualizations using data from the PM Projects folder, or any user-created folder that references the 
DA.PMPROJECT_V view:

BI Catalog Builder – Edit Data Sources 

NOTE: For this option, the ‘Use All Folders’ checkbox must also be checked in the visualization’s 
Fields pane in BI Dashboard Builder. Refer to Use All Folders section of this guide for more 
information.



14 • Dashboard Runtime Controls User Reference BI Dashboard Builder - ADF Tool

3. Visualizations using data from the PMBI Current Project folder or any user-created folder that 
references the CMIC_BI.PM_PROJECT view:

BI Catalog Builder – Edit Data Sources

NOTE: For this option, the ‘Use All Folders’ checkbox must also be checked in the visualization’s 
Fields pane in BI Dashboard Builder. Refer to Use All Folders section of this guide for more 
information.

If the ‘Current Project Only’ checkbox option is required for visualizations using any other folder, BI 
Catalog Builder needs to be used to create a join between that folder and the PM Projects or PMBI Current 
Project folder, or between that folder and a user-created folder that references the DA.PMPROJECT_V or 
CMIC_BI.PM_PROJECT view.
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Hide Logo – Checkbox

Use the ‘Hide Logo’ checkbox in the Dashboard Settings pop-up window to hide the logo displayed on the 
dashboard.

Logo 

This property allows the user to upload and display a custom logo. If the Logo property is left empty, the 
logo defaults from the Dashboard Logo Image Path field on the Logo Path tab of the System Options 
screen (standard Treeview path: System > Setup > System Options – Logo Path tab).

Show/Hide Properties 

This control is used to edit a visualization’s properties during runtime. To do so, select a visualization by 
clicking its header, then click this control to reveal the Visualization Properties control for the selected
visualization.

This functionality allows end-users to temporarily (no changes are saved) modify a visualization’s properties, 
such as changing how its data is filtered and sorted.

Refresh 

This control is used to refresh a dashboard’s visualizations using current data from the database.
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BI Dashboard Builder – Screen
File – Menu

File drop-down menu

New – Menu Option

Launches the above New Dashboard pop-up window with the following fields to fill out:

Field Details
Name Name for new dashboard, which auto-populates ID field.

ID
Identifier used by system to identify new dashboard, which is auto populated 
based on Name field; can use uppercase alphanumeric characters and underscore 
character, but spaces are not allowed.
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Field Details

Data Source
Contains the folders (i.e., tables/views) to use to create the dashboard’s 
visualizations (i.e., charts, gauges, tables). Visualizations can either use data 
from a single folder, or data returned by joined folders. 

After clicking [OK], the new dashboard is loaded and ready to have visualizations added to it.

Open – Menu Option

This option launches the above Search and Open Dashboard pop-up window to search for and select a 
dashboard to open.

NOTE: When BI Dashboard Builder is accessed for the first time, none of the provided, default dashboards will 
be available to any user, until they are granted appropriate security access. 

Use the Data Source, Name and/or ID search fields to find a particular dashboard, and note that the following 
wildcard characters can be used:

• % (any string of characters)

• _ (any single character)
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Use the [Advanced] button to switch the pop-up to Advanced Search mode, shown below:

In Advanced Search mode, matching operators can be used, search fields can be added, and the search fields can 
be reset and reordered. 

Export – Menu Option
The Export and Import functionality is used to copy dashboards from one Enterprise environment to another. 
For instance, if dashboards are created in the Test/Development environment, they can be copied to the 
Production environment using this functionality. 

Copying Dashboards Between Enterprise Environments

NOTE: To import dashboards into one environment from another, the environments must be on the same 
patch/hotfix level. For example, if dashboards are created in the DEV environment, to export them to the 
PROD environment, the PROD environment must be on the same patch/hotfix level as that of DEV.

To copy a dashboard from one environment to another, using BI Dashboard Builder, open the dashboard 
to copy in the environment it exists. Then, use this Export option to export (save) the dashboard to a 
location from which it can be imported. The exported dashboard will have a “BI” file extension. 

Next, launch BI Dashboard Builder in the environment into which the dashboard is to be imported. Then, 
use the Import option to import the dashboard that was exported to the temporary location.

NOTE: Imported dashboards are not automatically saved. Use the “Save” or “Save As” option to save and 
keep the imported dashboard.

Import/Export Rules

When working with multiple environments, where you are planning on developing in one environment 
(e.g. TEST or DEV) and then promoting these changes into another environment (e.g. PROD), the 
following rules and best practices for import/export should be considered:

1. Always make changes to your data source and dashboards in your development environment (e.g. 
TEST, DEV, etc.).

2. Once changes are completed and ready to be promoted into your production environment (e.g. PROD):
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a. Export your data source from the development database and import it into your production 
database. For more details, refer to the Installation Scripts section of the BI Catalog Builder 
guide.

b. Export your dashboards from the development environment and import them into your 
production environment. For more details, refer to the Export – Menu Option and Import -
Menu Option sections of this guide.

3. Importing a data source will override the existing data source in the destination environment, therefore, 
it’s important to follow Rule 1. 

4. If users modify a dashboard in the source environment, and these changes don’t require any 
modifications in the corresponding data source, then it’s not necessary to export/import the data source. 
In this case, users can skip Rule 2a. 

NOTE: If you export/import a dashboard between different environments and the dashboard required any 
changes in the corresponding data source, then you first need to export/import your data source as 
described in the Installation Scripts section of the BI Catalog Builder guide.

Import – Menu Option

This option is used along with the “Export” option to copy dashboards from one Enterprise environment to 
another. For details, please refer to the above documentation about the “Export” option.

Imported dashboards are not automatically saved. Use the “Save” or “Save As” option to save and keep the 
imported dashboard.

NOTE: If you export/import a dashboard between different environments and the dashboard required any 
changes in the corresponding data source, then you first need to export/import your data source as described in 
the Installation Scripts section of the BI Catalog Builder guide.

Save – Menu Option
Saves changes to dashboard.

NOTE: The user will be unable to save a dashboard if errors exist (missing fields, missing folder, etc.) and will 
be required to resolve these errors before the dashboard will save. This functionality prevents broken 
visualizations from becoming corrupted to the point that they become unrecoverable.

Save As – Menu Option
Brings up the Save As pop-up window, which can be used to create a copy of the current dashboard by saving it 
with a different name.
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Delete – Menu Option

This option launches the above Search and Delete Dashboard pop-up window to search for and delete a 
dashboard.

Use the Data Source, Name and/or ID search fields to find a particular dashboard, and note that the following 
wildcard characters can be used:

• % (any string of characters)

• _ (any single character)

Use the [Advanced] button to switch the pop-up to Advanced Search mode, where matching operators can be 
used, search fields can be added, and search fields can be reordered.

About – Menu Option
This option is used to display information about the application and its server.
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Dashboard – Menu

Dashboard drop-down menu

Rename – Menu Option

Launches the above Rename pop-up window to rename the dashboard.

Layout – Menu Option
These layout options control how visualizations are arranged on the screen:

Option Details

Flow
Visualizations are automatically arranged from left to right, and they dynamically wrap 
to new lines based on the browser’s size. To force a visualization to a new line, insert a 
line break before it using the “Insert Line Break” option.
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Fixed

Width and height of dashboard is specified, and its size does not change dynamically, 
but scrollbars are available if required; visualizations are arranged by user (as shown 
below), their positions are fixed, and they can be stacked.

Insert Filter (Page Filter) – Menu Option

This option is available if the screen is in Edit Mode. It is used to add a page filter to a dashboard to 
dynamically control the data displayed by one or more of the dashboard’s visualizations during runtime.

To clear a page filter’s selected item, use the Delete or Backspace keyboard key.

Adding & Configuring Page Filter
To add a page filter, select the “Insert Filter” option in the Dashboard drop-down menu, which creates a page 
filter at the top of the canvas if it is the first one added, or next to the previously added filter otherwise.

Next, drag and drop the filter over the visualization that is in the desired position for it, which causes that 
visualization to be moved to the right. If required, force a new line after the filter using the “Insert Line Break”
option, which positions the new filter over the visualization forced to the new line.
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Add Field to Filter Against From Data Source to Fields Pane 

With the new filter selected by clicking its colored header, click the up-arrow ( ) in the Fields pane to 
add the field to filter against from a selected data source to the Fields pane. For details about adding fields 
from a data source to the Fields pane, please refer to the following subsection, Fields – Pane.

Plotting Fields – Tab: Add Field to Filter Against From Fields Pane

As shown above, drag and drop the field just added to the Fields pane into the Filter By parameter of the 
Visualization Properties control.
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This creates a simple page filter with a pop-up that is auto-populated with relevant values to choose from, 
as shown below:

Sort and Filter – Tab: Sort & Filter Page Filter’s LOV

To sort and filter the page filter’s LOV, use the Visualization Properties control’s Sort and Filter tab, as 
shown above.  For details about the Sort and Filter tab, please refer to the following section: Sort and 
Filter – Tab.
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Format – Tab: Format Page Filter

Label: Allows the user to use an alternate label for the page filter, as opposed to using the Field name 
which defaults from the Filter By parameter of the Visualization Properties control.

Alignment: Used to set how page filter’s search box is aligned within the page filter.

Field Width: Used to set width of page filter’s search box.

Setting Which Visualizations Page Filter Filters
To set what visualizations get filtered by a page filter, add the folder used to create the page filter to all the 
visualizations that are to be filtered by it. Note, the fields used by the filter do not need to be added to 
visualizations, only the folder used by the page filter does, even if the folder is not used by the visualization. 
When a page filter is activated, it looks for visualizations with the same folder, and only ones with it are filtered.

Using Multiple Page Filters Jointly
If multiple page filters are added to filter visualizations jointly, their filter expressions are combined using the 
And conjunction. Also, page filters that jointly filter visualizations (filter jointly since created using same 
folder) filter each other.

For instance, for two page filters filtering jointly, one by company and the other by job, if a company is selected 
using the first one, the second one’s LOV is limited to only jobs belonging to the selected company. 

Insert Line Break – Menu Option
This option is available if the screen is in Edit Mode. To insert a line break, select the visualization for which 
the next visualizations will be forced to a new line.

Once inserted, the following graphic appears under the selected visualization to indicate where the line break 
was added: . The line break can be deleted by selecting its graphic and pressing the Delete keyboard key.
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Insert Substitution Variable – Menu Option

This option is available if the screen is in Edit Mode. It is used to filter visualizations using substitution 
variables to which substitution value expressions have been applied.

Adding & Configuring Substitution Variable
To add a substitution variable, select the “Insert Substitution Variable” option in the Dashboard drop-down 
menu, which creates a substitution variable search box at the top of the canvas.

Format – Tab: Format Substitution Variable

Use the Format tab to complete the substitution variable’s format information. The tab’s fields are 
described below.



User Reference BI Dashboard Builder - ADF Tool BI Dashboard Builder – Screen  •  27

Identifier: A unique name that is used to reference the value of this substitution variable. The identifier 
must start with a lowercase character and may only contain numbers, lowercase characters and 
underscores.

Label: Label for substitution variable.

Data Type: Sets the data type of the substitution variable. Options are “String”, “Number”, and “Date”. If 
“Date” is selected as the data type, the ‘Ignore Time’ checkbox will become enabled. In addition, a pop-up 
calendar will be available in the Substitution Variable search box.  Data validation will occur for Number, 
Date, and Time.

Ignore Time: This checkbox is only visible if “Date” is selected in the Data Type drop-down menu. This 
box is checked by default. When checked, time will be ignored. If unchecked, time can be specified. 

Alignment: Set how substitution variable’s search box is aligned within the substitution variable.

Field Width: Set width of substitution variable’s search box.
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Sort and Filter – Tab: Sort & Filter 

Use the Visualization Properties control’s Sort and Filter tab, as shown above, to enter substitution value 
expression(s) to the fields in the Filter panel. The value of a number or date criterion may contain one or 
more substitution value expressions (e.g. ${identifier}). 
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Substitution value expressions can be inserted by selecting them from the drop-down menu, as shown 
below.
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Click on the help icon in the Insert Substitution Expression pop-up window to display all available 
substitution value expressions.  Hovering over an expression in the help pop-up will show its resolved 
value.

A predefined substitution variable identifier always starts with an “&”. The following pre-defined 
substitution value expressions are available to use:

Predefined Substitution 
Value Expression

Description

${&today} This present day.

${&today ± n} This present day ± n days, where n is an integer.

${&startofweek} The first day of this present week. The first day of the week is 
always Monday. E.g.: If the present date is 2018-10-03, 
${&startofweek} is resolved to 2018-10-01.

${&startofweek ± n} The first day of this present week ± n days, where n is an integer.

${&startofweek(±m) ± n} The first day of the week that is ±m weeks away from this present 
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Predefined Substitution 
Value Expression

Description

week ± n days, where m and n are integers. E.g.: If the present 
date is 2018-10-03, ${&startofweek(1) + 3} is resolved to 2018-
10-11.

${&endofweek} The last day of this present week. The last day of the week is 
always Sunday. E.g.: If the present date is 2018-10-03, 
${&endofweek} is resolved to 2018-10-07.

${&endofweek ± n} The last day of this present week ± n days, where n is an integer.

${&endofweek(±m) ± n} The last day of the week that is ±m weeks away from this present 
week ± n days, where m and n are integers. E.g.: If the present 
date is 2018-10-03, ${&endofweek(-3) + 2} is resolved to 2018-
09-18.

${&startofmonth} The first day of this present month. E.g.: If the present date is 
2018-07-20, ${&startofmonth} is resolved to 2018-07-01.

${&startofmonth ± n} The first day of this present month ± n days, where n is an integer.

${&startofmonth(±m) ± n} The first day of the month that is ±m months away from this 
present month ± n days, where m and n are integers. E.g.: If the 
present date is 2018-07-20, ${&startofmonth(2) + 1} is resolved 
to 2018-09-02.

${&endofmonth} The last day of this present month. E.g.: If the present date is 
2018-07-20, ${&endofmonth} is resolved to 2018-07-31.

${&endofmonth ± n} The last day of this present month ± n days, where n is an integer.

${&endofmonth(±m) ± n} The last day of the month that is ±m months away from this 
present month ± n days, where m and n are integers. E.g.: If the 
present date is 2018-07-20, ${&endofmonth(-2) - 1} is resolved to 
2018-05-30.

${&startofquarter} The first day of this present quarter. E.g.: If the present date is 
2018-09-20, ${&startofquarter} is resolved to 2018-07-01.

${&startofquarter ± n} The first day of this present quarter ± n days, where n is an 
integer.

${&startofquarter(±m) ± n} The first day of the quarter that is ±m quarters away from this 
present quarter ± n days, where m and n are integers. E.g.: If the 
present date is 2018-09-20, ${&startofquarter(1) + 1} is resolved 
to 2018-10-02.

${&endofquarter} The last day of this present quarter. E.g.: If the present date is 
2018-09-20, ${&endofquarter} is resolved to 2018-09-30.

${&endofquarter ± n} The last day of this present quarter ± n days, where n is an integer.

${&endofquarter(±m) ± n} The last day of the quarter that is ±m quarters away from this 
present quarter ± n days, where m and n are integers. Eg.: If the 
present date is 2018-09-20, ${&endofquarter(1) - 1} is resolved to 
2018-12-30.

${&startofyear} The first day of this present year. E.g.: If the present date is 2018-
09-20, ${&startofyear} is resolved to 2018-01-01.
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Predefined Substitution 
Value Expression

Description

${&startofyear ± n} The first day of this present year ± n days, where n is an integer.

${&startofyear(±m) ± n} The first day of the year that is ±m years away from this present 
year ± n days, where m and n are integers. E.g.: If the present date 
is 2018-09-20, ${&startofyear(10) + 1} is resolved to 2028-01-02.

${&endofyear} The last day of this present year. E.g.: If the present date is 2018-
09-20, ${&endofyear} is resolved to 2018-12-31.

${&endofyear ± n} The last day of this present year ± n days, where n is an integer.

${&endofyear(±m) ± n} The last day of the year that is ±m years away from this present 
year ± n days, where m and n are integers. E.g.: If the present date 
is 2018-09-20, ${&endofyear(-10) - 1} is resolved to 2008-12-30.

${&userloginname} Login name of the current user.

${&userdisplayname} Display name of the current user.

${&glcompanycode} Default GL company code.

${&gldepartmentcode} Default GL department code.

${&projectoraseq} Current project oraseq.

${&partnertypecode} Partner type code of the current user.

${&partnercode} Partner or company code of the current user.

${&contactcode} Contact code of the current user.

NOTE: A visualization filter criterion is removed from the query when any of the following conditions occur:

 - Criterion value contains a substitution variable identifier that does not exist.
 - Criterion value is resolved to null or blank.
 - For number criteria, criterion value cannot be resolved to a number.
 - For date criteria, criterion value cannot be resolved to a date.

For more details about the Sort and Filter tab, please refer to the following section: Sort and Filter – Tab.

Reset Position of Visuals – Menu Option
This option is available if the “Layout” option is set to “Fixed”. It is used to rearrange the visualizations to their 
default positions, which is stacked on each other in a cascading manner. 

Get Link – Menu Option
This option launches a pop-up which displays the URL for the dashboard, which can be right-clicked and 
copied using the context menu that appears.
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Discard Changes – Menu Option
This option launches a pop-up which prompts the user to confirm the discarding of all unsaved changes. Click 
[OK] to revert the dashboard back to the way it was before the unsaved changes. 

Delete – Menu Option
This option launches a pop-up which prompts the user to confirm the deletion of current dashboard. Click [OK] 
to permanently delete it.

Preferences – Menu

Preferences drop-down menu

Autoload Data
The Autoload Data checkbox is intended for dashboard developers, to allow them to build dashboards faster, 
without waiting for data to load while building. This checkbox is a user setting of the Dashboard Builder tool 
and is not an attribute of a dashboard. The checkbox will stay checked or unchecked for each user (as it’s the 
user’s setting) and will apply to all dashboards (as it’s the tool’s setting).

When launching a dashboard via URL, the data will always be loaded.

NOTE: An option does not exist to turn autoload data on or off when a dashboard is launched via URL. 

By default, this checkbox is checked for the user. If checked, when a dashboard is loaded, data is automatically 
loaded for all visualizations. Otherwise, when a dashboard is loaded, visualizations will not be loaded with data, 
and to do so requires clicking the Refresh icon ( ). This is handy when building a dashboard, and you wish for 
it to load quickly.

NOTE: When “Autoload Data” is unchecked in the drop-down menu, the “Create User-Defined Log…” menu 
option is disabled in the Visualization Menu. This prevents user-defined logs from being created for inefficient 
queries (i.e. when the table query is timed out).
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Utilities – Menu

Utilities drop-down menu

Assign Roles to Dashboards – Dashboard Security

Assigning security roles to dashboards

To grant a user access to a dashboard, the security role to which the user belongs must be assigned to the 
dashboard. This can be done using the “Assign Roles to Dashboard” option under the Utilities menu of BI 
Dashboard Builder (shown above), by an administrator with the BISECMNG system privilege. This option is 
available without opening a dashboard. Depending on security setup, the administrator’s security role may also 
need to be assigned to the Assign Roles to Dashboards program. For more details, refer to Security Setup & 
Rules – Catalog & Dashboard Security in this guide.

NOTE: A link to launch the Assign Roles to Dashboards utility can be added as a new Console tab using the 
Console tool, or to a Treeview using the Treeview Builder tool. The Target for this utility, which is required by 
the tools to create a link to the utility, is “SD - Assign Roles to BI Dashboards”.

For details about dashboard security, please refer to the following section, Security Setup & Rules – Data 
Source & Dashboard Security.
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[Reading View] – Button

If the [Reading View] button is visible, the screen is in Editing View mode, as shown above, and the 
Visualizations and Fields panes are available to create and edit visualizations.

Click the [Reading View] button to switch the screen to Reading View mode, which displays the dashboard as 
it would be displayed to end-users, for review and testing purposes.

[Editing View] – Button

If the [Editing View] button is visible, the screen is in Reading View mode, as shown above, and the 
Visualizations and Fields panes are not available. In Reading View mode, the dashboard is displayed as it 
would be to end-users for review and testing purposes.

Click the [Editing View] button to switch the screen to Editing View mode, which is used to create and edit 
visualizations.
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Visualizations – Pane

The Visualizations Pane is only available when the screen is in Editing View mode, and its Visualization 
Properties control is only visible if a visualization has been selected in the dashboard canvas.

This pane is used to create and configure the dashboard’s visualizations, using its Visualizations Selector and its 
Visualization Properties controls.

Visualizations Selector – Control

The Visualizations Selector contains visualization icons that are clicked to add a new visualization to the 
dashboard, or clicked to change a selected visualization on the dashboard canvas to the clicked one.

If a visualization is selected on the dashboard canvas, its corresponding visualization icon in the Visualizations 
Selector is grayed out and its outline is highlighted.

The Help Icon ( ) can be clicked to view the Visualization Catalog, which contains graphical samples of the 
visualizations, in a new browser tab.
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Visualization Properties – Control
This section provides an overview of the Visualization Properties control, which is comprised of the following 
three tabs: Plotting Fields, Sort and Filter, and Format.

Plotting Fields – Tab

Bar, Column, Line &               Pie Charts                         Gauges                          Tables                            Images, Text
Area Charts

As shown above and explained below, the Plotting Fields tab differs between visualization types:

• Charts: Used to set which fields from the data source get graphed.

• Gauges: Used to set what field’s aggregate value is displayed; and optionally, what fields’ 
aggregate values are used to set the gauge’s minimum, maximum and target values.

• Tables: Used to set what fields are to be its columns.

• Images/Text: Used to set which field is used to display an image or text.

As shown in the Stacked Column Chart example below, to set what fields get graphed, drag and drop them from 
the Fields pane into the relevant plotting fields in the Visualizations pane:

For details about the plotting fields of each visualization type, please refer to the relevant subsection under the 
following section, Visualizations.
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Sort and Filter – Tab

 
The Sort and Filter tab is used to sort and filter the data displayed by the visualization. The following sections 
provide details about the Sort and Filter parameters.

Sort
To sort the items of a Group, Series or Column plotting field, drag the field by which to sort the items into the 
Sort box. If a single folder is used to create the visualization, only fields within it can be used for sorting; and if 
joined folders are used to create the visualization, only fields in the returned rows can be used for sorting.

By default, the sort method used is ascending, as indicated by the up-arrow icon ( ). Click the arrow to change 
the sort method to descending, which is identified by the down-arrow icon ( ).

More than one sort parameter can be specified, in which case data is first sorted by the first sort parameter, then 
by the second one and so forth.

To delete a sort parameter, click its corresponding Delete icon ( ).

Filter 
This parameter is used to create a filter expression, comprised of comparison operators and values to compare 
against, to perform two types of filtering:

• Data Filter
Filter rows (data) used to create visualization (i.e., filter rows in folder or filter returned rows 
of joined folders).

• Group/Series Filter
Filter groups along groups axis, if only the Group plotting field is specified, or filter series in 
visualization, if the Series plotting field is specified.

A filter expression can be a simple filter expression (e.g., “Invoice Amount is not blank”) or a composite filter 
expression that is comprised of two or more simple filter expressions joined by the “And” or “Or” conjunction 
(e.g., “Invoice Amount is not ‘0’ And PO Number is not blank”).

The following are the steps to create a simple filter expression, which are repeated to create a composite filter 
expression.

Create Simple Filter Expression:

1. Drag and drop the field to filter against from the Fields pane into the Filter box.
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2. Group/Series Filter Type: If and only if this simple filter expression is to be of the Group/Series 
Filter type, instead of the Data Filter type, click the down-arrow icon ( ) to select the relevant 
aggregate function; otherwise, skip this step.

The selected aggregate function is applied to the field dragged into the Filter box, and its result is 
used to filter the groups if only the Group plotting field is specified, or series, if the Series plotting 
field is specified.

If Groups are being filtered: the calculated aggregate value for each group is compared to the value 
that will be specified using the icon in step 3, and if a group’s value does not meet the criteria, it 
will not appear in the visualization.

If Series are being filtered: the calculated aggregate value for each series is compared to the value 
that is to be specified using the icon in step 3, and if a series’ value does not meet the criteria, it 
will not appear in the visualization.

Example:

For the following Stacked Column Chart, each Group’s aggregate value is broken down into 
aggregate values for each Series (vendor). 

If the following simple filter expression of the Group/Series Filter type is used:

“Sum of Outstanding Amount is greater than 50 000”

Then all series with a sum equal to or less than 50 000 will not be included in the chart, as 
shown below:
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3. To create the simple filter expression, click the up-arrow icon ( ) to specify the comparison operator 
and the actual value to compare against the dragged-in field.

For filters of the Data Filter type, the comparison operators available depend on the data type of the 
dragged-in field. For instance, if the dragged-in field is of the date type, the following notable 
comparison operators are available in the pop-up launched by clicking the filter parameter’s up-arrow 
( ): is after, is on or after, is before, is on or before; and a time may be specified for the entered date 
by unchecking the ‘Ignore Time’ checkbox in the pop-up.

For filters of the Group/Series type, the comparison operators available depend on the aggregate 
function’s type. 

Create Composite Filter Expression:

When creating composite filter expressions, the brackets matter in its evaluation. The following are details 
about how brackets are applied:

• each new simple filter expression is encapsulated by brackets

• filter parameters can have up to two simple filter expressions, (created in icon’s pop-up), and 
they are encapsulated by brackets

• filter parameters within each filter box are encapsulated by brackets, as shown in above 
screenshot

NOTE: Bolded conjunctions indicate that they are between expressions in filter boxes.

To view the created filter expression, click the icon. If no expression is shown, one has not been fully 
completed.

I. To create a composite filter expression, after creating a simple filter expression, either:

• drag and drop the field to use for the next simple filter expression into a Filter box, which 
automatically joins the new expression to the previous one in the box, if there was one, using the 
conjunction selected for the Filter box

OR
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• click a previously specified filter parameter’s icon to add another simple filter expression in 
its pop-up, and use the ‘And’ or ‘Or’ radio button to select the conjunction with which to join 
them

OR

• click the add icon ( ) to add another filter box, then drag in the field to use for its simple filter 
expression, and use the ‘And’ or ‘Or’ radio button to select the conjunction with which to join 
the new expression to the one of the previous filter box

II. Continue creating the simple filter expression as explained by the second or third step of the preceding 
Create Simple Filter Expression steps. 

Format – Tab

  
Bar, Column, Line & Area Charts                            Gauges                           Pie Charts, Tables, Images, Text

As shown above, the Format tab also differs between visualizations. It is used to format the visualization and to 
provide a title for it, which is displayed along the visualization’s header.

For details about this tab for each visualization type, please refer to the relevant subsection under Visualizations.



42 • BI Dashboard Builder – Screen User Reference BI Dashboard Builder - ADF Tool

Fields – Pane

This pane needs to contain all the folders and fields required for a visualization or a page filter (“Insert Filter”
option under Dashboard drop-down menu).

NOTE: If no business areas and fields are shown and the up and down arrows ( ) are not visible, no 
visualization is selected on the dashboard canvas.

To add fields to a visualization or a page filter, select it on the dashboard canvas and click the up-arrow ( ) in 
the Fields pane.

In the launched pop-up window (shown below), select a field to add in the Available pane, then click the single 
arrow (shown below) to move it to the Selected pane, which adds the field and its folder to the visualization.
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When a field is added to the Selected pane, if its folder has joins to more than one of the folders already selected 
(joins specified via BI Catalog Builder tool), a pop-up is displayed to select to which folder it is to be joined, as 
shown below:
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Join Tree

To view how the selected folders are joined, click the Join Tree icon ( ) to display the Join Tree pane.

The top-most folder is the root folder, and if it is removed from the Selected pane, all other folders will also be 
removed from the Selected pane.

By default, the Business Area displays the business area of the root folder. 

Using the following Join Tree as an example, Join Trees show how the selected folders are joined as follows:

• top-most (root) folder (JC Summaries) is joined to all sub-folders, but not to their sub-folders, e.g., JC 
Summaries is joined to JC Jobs, JC Categories, JC Job Phases, and GL Company

• sub-folders are joined to their sub-folders, e.g., JC Jobs is joined to SD Regions
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Removing Fields

When a field is deleted in BI Catalog Builder, visualizations in BI Dashboard Builder currently using the 
deleted field will no longer display properly. 

For the visualization to display properly, the missing field needs to be removed from the Fields pane. In order to 
be able to remove a field from the Fields pane, the field must not be used. If the field is being used as a plotting 
field, filter field, sort field, etc., the user will be prompted to remove its usages first. 

NOTE: A field is being used if its font is blue in the Fields pane; otherwise, an unused field’s font is black.

The screenshot below shows an example of a visualization not displaying properly because a field being used as 
a plotting field has been deleted. For the visualization to display properly, the user needs to remove the missing 
field’s usage first, in this case on the Plotting Fields tab, and then remove the field from the Fields pane. 

Example of removing a field from a visualization’s Fields pane 
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Editing Data Sources, Business Areas, Folders and Fields in 
Catalog Builder

Example of editing a folder in Catalog Builder by specifying position of folder node inside branch and applying a filter 
condition 

The order in which business areas, folders and fields are displayed in a data source tree is determined in Catalog 
Builder.  In the Property Pane section for each of these items, there is a property called Position which sets the 
position of the item’s node inside a data source branch. The Position property is editable, allowing the user to 
change the position of a node to control the order in which business areas are displayed in a data source, folders 
are displayed in a business area, and fields are displayed in a folder. 

In addition, users can specify filter conditions to restrict the number of records returned by a folder using the 
[Edit Filter] button. This feature is available to Enterprise and Cloud Catalog Builder clients only, and users 
must have the system privilege BICFDRFLTR to use it; otherwise, the button will be hidden.

The application that performs the actual restriction is Dashboard Builder. 

For example, the screenshot above shows an example of the folder “AP Batch GL Distributions” in Catalog 
Builder, in which the position of the folder node inside the business area (Accounts Payable) is specified as 
“10” and a filter condition has been specified for the folder so that it will only return records when its “Comp 
Code” is “ZZ”.

For more information, please refer to the BI Catalog Builder guide.
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Use All Folders

When checked, this option allows dashboard developers to specify that all selected folders must always be used 
to query for data. All folders will be displayed in blue to indicate that the option has been checked, as shown in 
the screenshot below.

NOTE: This option is not available at runtime.
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When this box is unchecked, if a folder is selected but its fields are not used in a visualization (or all its fields 
are removed by end users at runtime), then this folder will not be used in the query, potentially resulting in a 
different data set. 

In some cases, dashboard developers may need their visualizations to always use all selected folders, even if no 
fields are actually used.

An example of such a case would be for JC Jobs security. The JC Jobs folder includes job security functionality. 
This folder will only return jobs that the current user has access to, while other folders may return all data 
regardless of job security.

In order to apply job security to other folders in the visualizations, dashboard developers need to include the JC 
Jobs folder and have the ‘Use All Folders’ box checked. This way, the JC Jobs folder will always be included in 
the query, limiting the data being displayed to only those jobs to which the current user has access. If the ‘Use 
All Folders’ box is unchecked, the JC Jobs folder won’t be used if its fields are not used in the visualization or 
if end users remove its fields at runtime.
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Visualizations
Add, Edit, Delete, Reposition

Add Visualization
To add a visualization, select the desired visualization from the Visualization Selector, which creates an 
instance of the visualization on the dashboard canvas.

Edit Visualization
To edit a visualization, select it on the dashboard canvas by clicking its header, then use the Visualizations and 
Fields panes to edit it. Hovering the mouse over an unselected visualization in dashboard mode causes the 
header border to be highlighted in blue to indicate that the user can click the header to reveal more features.

NOTE: The Visualizations and Fields panes only have controls visible if a visualization is selected on the 
canvas.
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Delete Visualization
To delete a visualization, first select it by clicking its header, then open the Visualization Menu by clicking on 
the Ellipsis icon ( ) and select “Remove” from the drop-down menu. 

Reposition Visualization
If the Layout option is set to “Flow” in the Dashboard drop-down menu, to reposition a visualization, click and 
hold its header, then drag and drop it over the visualization that is in the desired position, causing that 
visualization to be shifted to the right.

If the Layout option is set to “Fixed” in the Dashboard drop-down menu, to reposition a visualization, click and 
hold its header, then drag and drop it to the desired position. If it is dropped on another visualization, it will be 
stacked on it.

Maximize and Restore

All visualizations can be enlarged or reduced using the Maximize and Restore function.  When a visualization is 
maximized, the Visualization Menu (Ellipsis icon) continues to be accessible. 



User Reference BI Dashboard Builder - ADF Tool Visualizations  •  51

Drill in Place

The Drill in Place feature is enabled by default for all visualizations, except for tables and gauges.  

NOTE: For more information on the Drill in Place feature for table visualizations, please refer to the subsection 
on Tables (Part 1: Plotting Fields) in this guide.

Drill in Place is enabled when a Group or a Series is marked as a drill-down filter, as shown in the screenshot of 
the chart visualization above, or the visualization has a Drill in Place target (to a dashboard or a specific visual 
on a dashboard), as shown on the screenshot of the gauge visualization below.
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When Drill in Place is enabled, the chart becomes clickable.  When the chart is clicked, the user is taken to the 
Drill in Place target defined for the visualization.  When the visualization does not have a Drill in Place target 
defined, the current dashboard is the default target.  Each Group value or Series value marked as a drill-down 
filter is sent to the target as a parameter filter. If page filters exist, all page filter values are also sent to the target 
dashboard.

The Parameter Filter pop-up window, launched from the Parameter Filter icon ( ), displays a history of 
viewed Drill in Place visualizations.  It lists all parameter filters for the entire dashboard. A parameter filter is a 
field-value list pair in this pop-up window. All parameter filters on this pop-up window are active and the 
operator between these parameter filters is “and”. Click on the arrow icon to open a target previously drilled 
into.  An underlined parameter is from a page filter. A page filter may contain multiple values, separated by a 
semi-colon (;).  The operator between a page filter value is “or”.
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To set what visualizations get filtered by a parameter filter, add the folder of the parameter filter's field to all 
visualizations that are to be filtered by it. Note, the filter's field does not need to be added to the visualizations, 
only its folder, even if the folder is not used by the visualization.  

During data retrieval for the visualizations, the system looks for visualizations with the same folder, and only 
ones with it are filtered.

The user can go back to any target that was drilled into. The Back icon ( ) allows the user to see the last Drill 
in Place dashboard that was viewed. Clicking on the Back icon discards the last set of parameter filters and 
takes the user “back” to the state prior to the creation of the last set of parameter filters.  The last Drill in Place 
visualization will be framed in green if it is drilling into the the same dashboard.

When drilling up, the state (excluding data) of the dashboard at the time of drilling down is re-displayed to the 
user instead of the latest version from the database.  This allows the user to see the same parent dashboard when 
drilling back up.  In addition, if the user made changes to the current dashboard and forgot to save before drill-
down, the changes to the current dashboard are not lost and the user can simply drill-up to retrieve them.

NOTE: The Parameter Filter icon and the Back icon appear on the upper right-hand corner of the dashboard, as 
well as on the currently selected visualization.  

Visualization Menu

Each visualization has a Visualization Menu, which is revealed by clicking the Ellipsis icon, as shown above.

Refresh
Used to refresh the visualization, as opposed to the entire dashboard, based on the most recent data.

Get Link
Used to get link to visualization, as opposed to link to entire dashboard. The link can be sent to someone to 
illustrate a communication, or it can be used to create a new Console tab or a new Treeview link to view the 
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visualization in the same way dashboards are made accessible, as per the following: Making Dashboards 
Accessible via Console.

The screenshot below shows an example of a link opened at the visualization level.  The visualization menu is 
located in the top right-hand corner of the display.

Remove
This option allows users to delete a visualization using a mouse and clicking on “Remove” in the drop-down 
menu. 

Duplicate
This option allows users to duplicate the currently selected visualization by clicking on “Duplicate” in the drop-
down menu. A copy of the selected visualization will appear on the dashboard.
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Replace

This option allows users to replace a visualization with a copy/reference visualization from another dashboard. 
Users can create a visualization on one dashboard and place it on other dashboards as a copy or reference 
visualization. A visualization can be copied/referenced multiple times.

A reference visualization is always taken from the source visualization when the dashboard is open. 
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The copy or reference visualization behaves the same as any other visualizations on the dashboard that it is 
placed. This includes being filtered by the page filters, substitution variables, etc. The user can modify the copy 
visualization and changes can be saved. Saved changes to the copy visualization do not update the original 
source visualization in any way.

The Reference visualization properties tab is only shown in Edit Dashboard mode. The user can use this 
properties tab to adjust the reference visualization’s width and height. 

In Reading View mode or during runtime, the end-user is not aware that the visualization is a reference 
visualization. 

NOTE: The user may not reference a reference visualization.

Create User-Defined Log
This option is only available for tables, as per the following: Create User-Defined Log based on Table.

Group Sorts
This option is only available for tables, as per the following: Remove Group Sorts (Keep Subtotals) and Remove 
All Group Sorts.

Sort Ascending
This option is only available for tables, as per the following: Sort Ascending.

Sort Descending
This option is only available for tables, as per the following: Sort Descending.
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About

Pop-up window launched from About in the Visualization Menu

This pop-up window provides additional details about the selected visualization.

Charts: Bar, Column, Line & Area

Part 1: Plotting Fields

Example of Stacked Column Chart Visualization

Group

For the aggregate value displayed by the Value plotting field (e.g., Sum of Outstanding Amount in above 
screenshot), its component values (i.e., subtotals) are grouped by the field dragged into this plotting field, 
and a bar/column graphically displays each group’s value in relation to the Value axis. If the Series
plotting field is not used, these bars/columns are solid.

This plotting field is optional, and if it is not used, just one bar/column displays the aggregate value 
displayed by the Value plotting field.

Series (Subgroup)

Optionally, each group’s value, which is graphed using a solid bar/column if this plotting field is not used, 
can be further broken down into component values for the field dragged into this plotting field. If this 
Series plotting field is specified, the solid bar/columns are divided into colored segments for each Series 
item (e.g., Vendor Names in above screenshot).
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Value

Result of inputting dragged in field into aggregate function defaulted or selected via the down-arrow ( ).

If both the Group and Series plotting fields are not used, just one bar/column displays this field’s 
aggregate value.

Part 2: Sort & Filter
For details about sorting the Groups and Series, please refer to the previous subsection, Sort and Filter – Tab.

Part 3: Format

Y-Axis

Start: Value at which Y-axis is to start.

End: Value at which Y-axis is to end.

Title

Text: Title for visualization, which is displayed along its header.

Drill in Place

Target Dashboard: Specifies a Drill in Place target to a dashboard. 

Target Visual: Specifies a Drill in Place target to specific visual on a dashboard (when a target dashboard 
has been selected in the Target Dashboard field above)
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Other

Width: Shows the width of the visualization (editable to allow the user to adjust width).

Height: Shows the height of the visualization (editable to allow the user to adjust height).

Show Border – Checkbox: Check to apply border to visualization.

Items Per Page: Specifies how many data items are displayed per page in charts (maximum allowed value 
is 150).
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Pie Charts

Part 1: Plotting Fields

Example of Pie Chart (3D) Visualization

Series

For the aggregate value displayed by the Value plotting field (e.g., Sum of Outstanding Amount in above 
screenshot), its component values (i.e., Series) are grouped by the field dragged into this plotting field, and 
they are graphically displayed by pie slices.

Value

Result of inputting dragged in field into aggregate function defaulted or selected via this plotting field’s 
down-arrow ( ).

Part 2: Sort & Filter
For details about sorting the Series items, please refer to the previous subsection, Sort and Filter – Tab.
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Part 3: Format

Title

Text: Title for visualization, which is displayed along its header.

Drill in Place

Target Dashboard: Specifies a Drill in Place target to a dashboard. 

Target Visual: Specifies a Drill in Place target to specific visual on a dashboard (when a target dashboard 
has been selected in the Target Dashboard field above).



62 • Visualizations User Reference BI Dashboard Builder - ADF Tool

Other

Width: Shows the width of the visualization (editable to allow the user to adjust width).

Height: Shows the height of the visualization (editable to allow the user to adjust height).

Show Border – Checkbox: Check to apply border to visualization.

Value As Slice Label – Checkbox: Specifies whether labels on Pie Chart slices show values as a percent 
or as an amount.  If unchecked, values will be shown as a percent, and amounts will appear in a pop-up 
label when the user hovers over a slice of the pie chart.  If checked, values will be shown as amounts, and 
percent will appear in a pop-up label when the user hovers over a slice of the pie chart.

Max Slices to Show: Sets the maximum number of slices to show in the visualization. 
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Gauges

Part 1: Plotting Fields

Example of Gauge Visualization

Value

This plotting field is used to set how the value displayed at the center of the gauge is calculated. To set the 
value, drag in the relevant field from the Fields pane that is to be inputted into an aggregate function to 
calculate the value. Upon dragging in the field, a default aggregate function will be applied, according to 
the field’s data type. Use the down-arrow ( ) to bring up a popup to select a different aggregate function, 
if required.

This value can be displayed as a number or as a percentage of the gauge’s max value, as set by Callout 
Value option on the Format tab of this control.

Minimum Value

This plotting field is used to set the gauge’s minimum value, by dragging in a field from the Fields pane. 
The value is then calculated using the dragged-in field and the default aggregate function for its data type. 
If the dragged-in field is of the string or date type, the default function is Count, and if it is of the number
type, the default function is Sum.

Maximum Value

There are two ways to set the gauge’s maximum value: via this plotting field or via the Max field under 
the Gauge Axis option on the Format tab. This field takes precedence over the one on the Format tab.
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For this field, the maximum is calculated using the dragged-in field and the default aggregate function for 
its data type. If the dragged-in field is of the string or date type, the default function is Count, and if it is of 
the number type, the default function is Sum.

If the maximum value is not provided, it will be calculated by doubling the current value, which 
essentially sets the gauge’s current value in the middle of the gauge. Therefore, the start value (minimum 
value) will be set to “0” and the end value (maximum value) will be set to double the current value. We 
recommend that users specify the source for the maximum value, either through this Maximum Value 
plotting field or through the Max field under the Gauge Axis option on the Format tab, if a maximum 
value is required on the gauge’s visualization.

Target Value

There are two ways to set the gauge’s target value: via this plotting field or via the Target field under the 
Gauge Axis option on the Format tab. This field takes precedence over the one on the Format tab.

This plotting field is used to set the gauge’s target value, by dragging in a field from the Fields pane. The 
value is then calculated using the dragged-in field and the default aggregate function for its data type. If 
the dragged-in field is of the string or date type, the default function is Count, and if it is of the number
type, the default function is Sum.

Part 2: Sort & Filter

For details about filtering the data used by a gauge, please refer to the previous subsection, Sort and Filter –
Tab.
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Part 3: Format
Gauge Axis

Attribute Details

Min Minimum value of gauge’s range.

Max Maximum value of gauge’s range, which can also be set on 
Plotting Field tab; setting on Plotting Field tab takes precedence.

Target
Gauge’s target value, displayed as line on gauge, which can also 
be set on Plotting Field tab; setting on Plotting Field tab takes 
precedence.

Start Angle

Position at which gauge’s range starts; if Angle Extent
(following attribute) is set to 360, the range starts at the 
following clock positions for the following values:

• if set to 0, starts at “3 o’clock”
• if set to 90, starts at “12 o’clock”
• if set to 180, starts at “9 o’clock”
• if set to 270, starts at “6 o’clock”

Angle Extent This setting affects the gauge’s shape, e.g., if set to 180, the 
gauge is a half-circle. 

Thresholds

There are four thresholds that can be defined. For each one, set its 
maximum value and the color for its range.

Title 

Text: Used to set the title for the visualization, which is displayed along its 
header.

Callout Value

Text Type: Used to set whether the value displayed by the gauge is 
displayed as a number or as a percentage of the max.

Drill In Place

Target Dashboard: Used to specify a Drill in Place target to a dashboard.

Target Visual: Used to specify a Drill in Place target to specific visual on 
a dashboard (when a target dashboard has been selected in the Target 
Dashboard field above).

Other

Width: Shows the width of the visualization (editable to allow the user to 
adjust width).

Height: Shows the height of the visualization (editable to allow the user to 
adjust height).

Show Border – Checkbox: Check to apply border to visualization.

Hide Footer – Checkbox: Check to hide footer at bottom of gauge.
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Gauge (Number)

Another variation of the gauge is the Gauge (Number) visualization. It’s a gauge without a status indicator. The 
format of this visualization is similar to that of the standard gauge visualization described in the previous 
section, except for some additional format properties listed under the Callout Value:

Callout Value

Text Type: Used to set whether the value displayed by the gauge is displayed as a number or as a 
percentage of the max.

Display Unit: Used to set the value’s display unit (e.g. thousands, millions, billions, etc.), if desired;
otherwise, default display unit is set to “Auto”. (Note: This property is only applicable if the Text Type is 
“Number”.) 

Format: Used to set the number format of the displayed value to show more or less digits, if desired;
otherwise, default format is set to “Auto”.

Alignment: Used to align the value displayed by the gauge (alignment options are “Left”, “Centre”, or 
“Right” aligned).

Size: Used to define the font size of the displayed value.

Weight: Used to set the font-weight or thickness of the value’s font (font-weight options are “Bold”, 
“Normal”, or “Lighter”).

Color: Used to determine the color of the value displayed by the gauge.
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Tables

Part 1: Plotting Fields

Example of Table Visualization

Column

Drag and drop fields from the Fields pane that are to be columns in the table into the Column box of the 
Plotting Fields tab.

If the dragged-in field is of the URL data type instead of the String data type, the column’s text is 
displayed as a hyperlink. A field’s data type can be changed from the String type to the URL type via BI 
Catalog Builder. For details, please refer to the BI Catalog Builder reference guide.

Also, if a table is created using a special Advanced Analytics view, which is a special view that contains a 
column with links to each record’s screen, the column with the links, titled Entry Screen, is automatically 
added to the table. For details, please refer to the upcoming section, Create BI Springboards.
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Column Line Aggregation 

Example of table visualization with a Number data type field

For columns of the Number data type, such as the Spent to Date column in the above screenshot, a down-
arrow ( ) is available to select an aggregate function for them, as shown below:

When an aggregate function is selected for a column, the aggregate function is used to calculate a single 
value for the column, for every unique line.
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The uniqueness of a line is determined by the values of its non-aggregated columns, hence the columns to 
include in the table must take this into consideration.

For instance, in the following screenshot, the Inv Amt column is to be the aggregated column, so the 
Vendor Code, Vendor Name, Due Date: Year and Due Date: Month column values are used to determine
the uniqueness of a line.
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After selecting an aggregate function for the Inv Amt column, the aggregate value for each unique line is 
calculated, as shown below:

Column Label, Group Sort, Column Aggregation 
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Label

Use this property to change the column’s title. If the column title is changed, hovering over it reveals 
its default title.

Alignment

Use this property to change the column’s alignment. Alignment options are “Left”, “Centre”, or 
“Right” aligned. This property is also applied to PDF and Excel exports.

Visible – Checkbox

Use this property to show/hide the column in ADF, PDF exports, and Excel exports.

Group Sort, Line Thickness, Line Style, Line Color (Group Sorting)

Tables provide the option of group sorting their rows by particular fields (columns).

To create a group sort, click the relevant field’s up-arrow ( ) to launch the pop-up, shown above. In 
the pop-up, check the ‘Group Sort’ checkbox, and optionally, use the Line Thickness, Line Style, and 
Line Color properties to select the line’s thickness, style and color.

If more than one field (columns) is to be group sorted, a thick line can be set for the first group sort and 
a thinner line for the second one, as shown in the previous screenshot. A different line style and line 
color could also be used for each group sort to further distinguish them.

On the Sorts & Filters tab, fields that are group sorted appear at the top of the Sort box and they have 
an asterisk at the end of their name.
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In the table, as shown in the previous screenshot, rows that are group sorted by fields only have their 
first row displaying the name of the group sorted fields. If the grouped rows continue to the next 
table’s page, the first row on the new page displays the field names in italics, as shown below: 

Also, for the Visualizations Properties Control, dropping a field that is not group sorted between two 
fields that are, makes the dropped field a group sorted one. 

NOTE: For the Visualization Properties Control, all fields added to the Column box on the Plotting 
Fields tab are automatically added to the Sort box on the Sorts & Filters tab. Also, if a field is added to 
the Sort box on the Sorts & Filters tab, it will automatically be added to the Column box on the 
Plotting Fields tab.

Visible, Label, Calculate (Column Aggregation)

These properties are used to set an aggregate value to display at the bottom of the column, as shown 
below on the right.

The ‘Visible’ checkbox sets whether or not the aggregate value is displayed for the column, the Label
field is used to provide a label for the aggregate value, and the Calculate field is used to select the 
aggregate function.
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Drill Down Filter, Target Dashboard, Target Visual, Copy Targets to (Drill in Place)

These properties are used to add a Drill in Place for a table 
visualization. This feature is disabled by default for table and gauge 
visualizations, but for all other visualizations it is enabled by default. 

Drill in Place is enabled for a table visualization when a column is 
marked as a drill-down filter or has a Drill in Place target defined (to a 
dashboard or a specific visualization on a dashboard).

The ‘Drill-down Filter’ checkbox is used to mark a column as a drill-
down filter and the Target Dashboard field is used to select a dashboard 
as a Drill in Place target.  The Target Visual field is used to further drill 
down into the dashboard to target a specific visualization. The ‘Copy 
Targets to…’ checkbox, when checked, replicates the Drill in Place 
target defined for the column to all other columns.

When Drill in Place is enabled, each regular cell (not including a 
subtotal) is clickable. When a cell with Drill in Place enabled is clicked, 
the user is taken to the Drill in Place target defined for the column. 
When the column does not have a Drill in Place target defined, the 
current dashboard is the default target. 

Each drill-down filter cell value on the row is sent to the target as a parameter filter. 

Pivot Items can also be marked as a drill-down filter.

When Drill in Place is enabled for a table visualization, and the cells are clickable, the user can enable 
text selection by using the Visualization drop-down menu and selecting “Enable Text Selection”.  
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Subtotals 

Example of table visualization with various subtotals set up

To create a subtotal line, click the Subtotals icon, shown below:

NOTE: Subtotals are not computed for columns that are group sorted.

In the pop-up, click the New icon, pointed to below: 
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In the Create Subtotal pop-up, define the subtotal line, using the following details.

Calculate

Use this field’s LOV to select the aggregate function that is to be applied to the field selected via the 
Place subtotal at each change in field.
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of all data points 

By default, all numerical fields will have an aggregate value calculated. This pop-up is used to exclude 
a field from having its aggregate value calculated.

Place subtotal at each change in

Select the field that is to be aggregated.

For each unique value of the field (e.g., if the field is “Job”, then for each job), the calculated aggregate 
value for it will be displayed just after the last entry for that field. 
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Don’t display subtotal for a single row

If checked, single rows will not have an aggregate value calculated.

Label

Label for aggregate value rows.

Append Value – Checkbox

If checked, name of field being aggregated will be appended to label identified in Label field above.

Bold

If checked, text for aggregate value rows is in bold.

Font color

Color of text for aggregate value rows.

Background color

Background color for aggregate value rows.

Part 2: Sort & Filter
Tables have unique sorting options for their rows, explained here. For general details about sorting rows, please 
refer to the previous subsection, Sort and Filter – Tab.

For tables only, the fields in the Sort box on the Sorts & Filters tab can be reordered by dragging and dropping 
them to their new positions, which changes the order by which rows are sorted (rows are first sorted by first 
field, then by second one and so forth).

The arrows next to the fields indicate their sort order. The up arrow ( ) indicates that the ascending sort order is 
used, and the down arrow indicates that the descending sort order is used. Click the arrows to switch between 
the two sort types.

NOTE: All visualizations, including tables, can filter by aggregation. For table visualizations, the table must 
have at least one aggregate column (aggregation is not “None”).
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Part 3: Format

Title

Text

Title for table, which is displayed along its header.

Export to PDF 

The following are options for the Export Table to PDF functionality. For details, please refer to the Export 
Table to PDF subsection.

Orientation

PDF’s page orientation. Options are “Landscape” or “Portrait”.

Size

PDF’s size. Options are “Letter” or “Legal”.
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Hide Logo – Checkbox

Allows user to hide PDF/query logo.

Logo

File name of uploaded logo for exported PDF. To clear this field, use the Delete or Backspace 
keyboard key.

NOTE: If this field is left empty, the logo will default from the Dashboard Logo Image Path field on 
the Logo Path tab of the System Options screen (standard path: System > Setup > System Options –
Logo Path tab).

Subtitle & Footer Text

Subtitle and footer text to be printed on the subtitle and footer of each PDF page. Custom subtitle and 
footer text may contain any of the available substitution value expressions, including substitution 
variable value expressions, filter value expressions, and pre-defined variable value expressions. For a 
list of available pre-defined substitution value expressions, please refer to the table in the following 
section of this guide: Insert Substitution Variable – Menu Option”.

Other

Width

Shows the width of the visualization. This field is editable to allow the user to adjust the width.

Height

Shows the height of the visualization. This field is editable to allow the user to adjust the height.

Show Border – Checkbox

Check to apply border to visualization.

Rows Per Page

Available if ‘Enable Pagination’ box is checked, to set number of rows to display per page of table.

Enable Pagination – Checkbox

If checked, a table visualization’s rows span over pages, as shown below:
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If unchecked, a scrollbar is used to view a table’s rows, as shown below:

Show Pivot Bar – Checkbox

If checked, the Pivot Items bar appears above the table’s columns, as shown above. Alternatively, 
during runtime, the Pivot Items bar can be made available by dragging and dropping a column header 
onto the table’s title bar, as shown below:
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The Pivot Items bar is used at runtime to filter the table by entries in one or more columns.

For instance, using the above table as an example, if you want the table to display data for a particular 
vendor, drag and drop the Vendor Name column header onto the Pivot Items bar, as shown below:

Next, click the icon (framed below) to select one or more vendors by which to filter the table’s data. 
Hold the Ctrl or Shift keyboard keys to select more than one item.

As shown below, more than one column can be dragged and dropped onto the Pivot Items bar:

To clear a Pivot Item’s selected item, use the Delete or Backspace keyboard key.

Wrap Cell Text

If checked, when a column is not wide enough to fully display its text, the height of the row is 
increased to fully display the text. Note, however, text wrapping does not occur for columns with a 
subtotal defined, or columns with a group sort defined with the Line Thickness property set to anything 
other than “No Line”.
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If not checked, when a column is not wide enough to fully display its text, the height of the row does 
not change, and the text is cut off.

Keep Line Breaks

This option is available if the ‘Wrap Cell Text’ box is checked, and it is used to preserve text 
formatting.

Tables at Runtime

Column Menu

To open a table column drop-down menu, hover your mouse over the column header and click on the down 
arrow. 

Hierarchy

The Hierarchy menu option allows users to insert columns belonging to the same hierarchy to the table. A 
column’s hierarchy list can contain fields from folders that are not the column’s folder. A field hierarchy 
contains a root field and all its descendants.

NOTE: The hierarchies are defined in BI Catalog Builder, where the user can group any data type fields 
(same data type or mix) to form a hierarchy. For more information, please refer to the Editing Fields
section of the BI Catalog Builder guide.
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Data source security is applied to the fields in the Hierarchy submenu and the only fields displayed will be 
the ones to which the user has access.

When the user selects a field from the submenu, if the field was not previously selected for the table, it 
will be automatically added to the table.

A column’s field hierarchy list is created as follows:

• Start with all fields in the column’s field hierarchy.

o Remove all fields that the user does not have authorization to use.

o Remove all fields that were already added to the table as columns.

o Remove all fields whose folders are not selected in the Fields pane.

Sort Ascending

Each column can be sorted in ascending order using this menu option.

Sort Descending

Each column can be sorted in descending order using this menu option.

Remove Column

Use this option to remove a column from a table visualization.

Reordering Columns

As shown above, a column can be drag and dropped to a new position by clicking and holding the column’s 
header and then dragging it to its new position.

To reorder the position of a column, hover over its column header to reveal the Move cursor, then click and 
hold it and drag it to the desired position. Save the dashboard to save the column’s new position.
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Resizing Columns

To resize a column, hover the cursor over the column’s border to reveal the Resize cursor (shown above), then 
click and hold the border and drag it to the desired position. Save the dashboard to save the columns new width.

Query By Example (QBE)

As shown above, a filter icon is available on the top-right of a table’s header to Query by Example.

When the icon is clicked, a row of fields appears above the table column headers for the user to enter QBE 
expressions for each of the table’s columns. Details on comparison and logical operators available to use in the 
expression fields for String, Number and Date columns are provided below.

Each table column can be queried for blank fields by clicking on the arrow button beside each expression field 
and selecting “is blank” or “is not blank” from the drop-down menu.

NOTE: The Value Case Hint field property, which is specified in BI Catalog Builder, can be used to generate 
SQL queries that may benefit from database column indexes. This field property is used to set whether values in 
a field are always uppercase or lowercase, which allows for a faster case-sensitive search in dashboard filters. 
However, users should only set this field property if the letter case of the column value is known, as inaccurate 
search results may be generated if set incorrectly. Refer to the BI Catalog Builder guide for more information. 

After entering the QBE expressions, users can execute the query by pressing Enter on their keyboard. Invalid 
QBE expressions will not be included in the query.

NOTE: QBE is also applied to PDF and Excel exports.
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Comparison Operators

The following comparison operators are supported:

Operator Description

> Greater than

< Less than

>= Greater than or equal to

<= Less than or equal to

= Equal to

!= Not equal to

<> Not equal to

Logical Operators

The logical operators “and” and “or” are supported. They are case-insensitive. Only one logical operator 
is allowed per QBE expression.

Columns

• STRING: For a STRING column, a QBE value without a comparison operator prefix is implicitly 
assigned the startsWith operator.

• NUMBER: For a NUMBER column, a QBE value without a comparison operator prefix is 
implicitly assigned the = operator.

• DATE: For a DATE column:

o The From date is implicitly assigned the >= operator.

o The To date is implicitly assigned the <= operator.

o When From date is empty, it is defaulted to the minimum date value for the column.

o When To date is empty, it is defaulted to the maximum date value for the column.
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Export Table to PDF

As shown above, a PDF icon is available on the top-right of a table’s header to export the table’s data to a PDF 
file.
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Below is a screenshot of the above table’s exported data in a PDF file:
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The following options are available for the Export to PDF functionality on the Format tab of the Visualization 
Properties control, as shown below. They are used to set the PDF’s page orientation and size, to upload a logo, 
and to specify subtitle and footer text for the PDF.

Example of the export to PDF functionality on the Format tab of the Table Visualization Properties control

As shown in the above screenshot, a logo can be displayed in the upper left corner of the exported PDF.  If the 
Logo property is left empty on Format tab of the Visualization Properties control, the logo defaults from the 
Dashboard Logo Image Path field on the Logo Path tab of the System Options screen (standard path: System > 
Setup > System Options – Logo Path tab), as shown below.  Note, the URL to the image must be publicly 
accessible (no authentication).

Otherwise, the user can upload a substitute logo in the Logo property on the Format tab of the Visualization 
Properties control which will display on the PDF instead. To clear a substitute logo from the Logo property on 
the Format tab, use the Delete or Backspace keyboard key.

Custom subtitle and footer text may contain any of the available substitution value expressions. Click on the 
arrow next to the Subtitle or Footer Text fields in the Format tab to launch a pop-up window where substitution 
values can be selected. Click on the help icon in the pop-up window to show all substitution value expressions, 
including substitution variable value expressions, filter value expressions, and pre-defined variable value 
expressions.  

For a list of available pre-defined substitution value expressions, please refer to the table in the following 
section of this guide: Insert Substitution Variable – Menu Option.
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The format for a page filter value expression is: ${@visualizationId}. The visualizationId can be obtained from 
the page filter’s About menu option (e.g. ${@e0}), as shown in the screenshot above. 

An example of the resulting exported PDF is shown in the screenshot below.
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Notes for Exporting Data to PDF 

• The following items are exported from a table to a PDF file:

o Column sorts (ascending/descending)

o Group Sorts

o Group Sort Lines, including color & thickness

o Subtotals, including font & background color 

o Grand totals

• Latest data is exported, and latest page filter values are applied.

• URLs in columns become hyperlinks in PDF.

• When necessary, an export is queued, with a message stating position in queue as follows, "Please Wait. 
You are currently in position X."

• Maximum amount of time a PDF export can run to completion is 5 minutes; after 5 minutes, a timeout 
message is displayed, asking the user to narrow the data selection; an incomplete PDF file is still 
downloaded, with the prefix "Incomplete".

• Characters from most writing systems (languages) are supported; if unknown characters are found during the 
export process, the unknown characters are replaced with the character .

Export Table to Excel

As shown above, an Excel icon is available on the top-right of a table’s header to export the table’s data to an 
Excel spreadsheet. Below is a screenshot of the above table’s exported data in Excel:
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Notes for Exporting Data to Excel

• CMiC BI is a data charting/analyzing tool that presents data in BI dashboards and is not designed to be 
used as a data export tool. While Excel export functionality exists in BI, it is only meant to assist users 
with formatting and printing dashboard data. For assistance with tasks specifically related to exporting 
customer data, we recommend that users contact CMiC Support.

• The following items are exported from a table to an Excel file:

o Wrap Cell Text option

o Column sorts (ascending/descending)

o Group Sorts

o Group Sort Lines, including color & thickness (line thickness of 1 becomes an Excel thin line; line 
thickness more than 1 becomes an Excel thick line)

o Subtotals, including font & background color 

o Grand totals

o Pivot items

• Latest data is exported, and latest page filter values are applied.

• URLs in columns become hyperlinks in Excel:

• When necessary, an export is queued, with a message stating position in queue as follows, "Please Wait. 
You are currently in position X."
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• Maximum amount of time an Excel export can run to completion is 5 minutes; after 5 minutes, a timeout 
message is displayed, asking the user to narrow the data selection; an incomplete Excel file is still 
downloaded, with the prefix "Incomplete".

• When a large amount of data is exported, the actual number of exported records varies depending on the 
system load at the time of export.

• If export cannot be completed due to a timeout, try limiting the amount of exported data using filters.

• Characters from most writing systems (languages) are supported; if unknown characters are found during 
the export process, the unknown characters are replaced with the character .

Create User-Defined Log based on Table

This feature is used to create a user-defined log in CMiC Field (PM JSP) based on a table visualization, and it is 
only available to users with the system privilege BILOGCRT (CMIC BI: Allows the user to create User-
Defined Logs). Also, this option is only available in BI Dashboard Builder – it is not available in dashboards at 
runtime.

NOTE: Only users with the system privilege will be able to see the Create User-Defined Log menu item; 
otherwise, the menu item will be hidden.

To create a User-Defined Log screen in CMiC Field, after a table is created, select the Create User-Defined Log
option from the table’s Visualization Menu (shown above).

To have the User-Defined Log filtered for particular values, use Pivot Items, as detailed under the following 
section: Part 3: Format.

If page filters, visual filters or ‘Current Project Only’ checkbox filter are defined in Dashboard Builder 
properties, these properties will be replicated in CMiC Field’s user defined logs. 

Grant Security Access to New Log’s Treeview Link 
When the new User-Defined Log is created, the user that created it is automatically granted rights to the 
Treeview link for the new log.

Security access to the log’s Treeview link for other users or for CMiC Field security roles is granted using the 
“Assign Menu Items” option in the Role Maintenance or User Access screen, as shown below. 
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After security access to the new User-Defined Log has been granted, the log may need to be manually added to 
the CMiC Field Treeview menu using the Menu Maintenance screen. Locate and drag the custom log from the 
Default menu into the Current Project Menu and click on [Save]. 
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The new User-Defined Log will now be available under the User-Defined Logs Treeview node in CMiC Field:
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Edit User-Defined Log
After the User-Defined Log has been created, like any other User-Defined Log, it can be edited using the User-
Defined Log Types and User-Defined Logs screens:

Remove Group Sorts (Keep Subtotals)

This option is used to remove all Group Sorts set up for the table but to keep Subtotals for Group Sorts.

The Group Sort option for tables is discussed in the following subsection for tables: Part 1: Plotting Fields.
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Remove All Group Sorts

This option is used to remove all Group Sorts (including Subtotals for Group Sorts) set up for the table.

The Group Sort option for tables is discussed in the followig subsection for tables: Part 1: Plotting Fields.

Sort Ascending

This option aligns the table’s sort order to the order of the columns and sorts the table’s columns in ascending 
order. The sort method selected, ascending in this case, is reflected in the Sort & Filters tab of the Visualization 
Properties control, as indicated by the up-arrow ( ).

Example of Visualization Properties control showing ascending sort method
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Sort Descending

This option aligns the table’s sort order to the order of the columns and sorts the table’s columns in descending 
order. The sort method selected, descending in this case, is reflected in Sort & Filters tab of the Visualization 
Properties control, as indicated by the down-arrow ( ).

Example of Visualization Properties control showing descending sort method



98 • Visualizations User Reference BI Dashboard Builder - ADF Tool

Create BI Springboards
As explained in the overview, BI Dashboard Builder can also be used to create BI Springboards, which are 
dashboards with springboard (link-out) capabilities, as tables provide the ability to springboard to record 
screens to view further details, edit data, and to perform actions like replying to RFIs, approving requests, 
changing voucher compliance statuses, and updating equipment details, as shown below:

For a table to have this springboard ability, it must use a folder of the Advanced Analytics type, which is a 
special view that contains a column with links to each record’s screen. Some such views (i.e., folders) are 
included in the provided default data source (CMiC Default Data Source), and they are identified in BI Catalog 
Builder by the “BI” suffix in a view’s (i.e., folder’s) name, as shown below:
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Calculated (Custom) Fields
Visualizations can use calculated fields, which are custom fields created and added to a folder in BI Catalog 
Builder, using the Create Calculated Field pop-up shown below:

When a calculated field is added to a folder (i.e., table/view), a column for the new field is added to it, and each 
of its rows has the new calculated field.

For each row, the calculated field displays the result of an SQL expression, which can include any Oracle SQL 
function and operator, and can contain references to any fields in the folder to specify values. A field referenced 
in an SQL expression represents the value of that field in the particular row of the calculated field being 
evaluated.

For details about creating and adding calculated fields to a folder, please refer to the BI Catalog Builder guide.
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Date Fields

Date Calculated Fields
As shown below, every field in a folder that is of the date data type has three corresponding calculated fields: 
one for the year component, one for the month component, and one for the day component. As shown below, 
these corresponding calculated fields are added to the end of a folder’s list of fields:

These date calculated fields can be added to visualizations in order to sort or group their data by year, 
month or day.



User Reference BI Dashboard Builder - ADF Tool Visualizations  •  101

Date and Number Formats
For fields of the date and number data type, the format to use to display their dates is set in BI Catalog Builder 
using the Default Format property in the Field Properties section of the Edit Data Source option, as shown 
below:

Example of Edit Data Source option of BI Catalog Builder tool for date type fields
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Example of Edit Data Source option of BI Catalog Builder tool for number type fields

For table visualizations, the user can also modify the format to use for date and number type fields in Dashboard 
Builder, as shown in the screenshot below.
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Example of modifying format for Number type field for a Table in Dashboard Builder. 

NOTE: For charts, number and date type fields are formatted as per the default format specified in Catalog 
Builder.

Images

Example of Image Visualization
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Part 1: Plotting Fields

Image URL

This plotting field is used to set the image to be displayed in the visualization. To set the image, drag the 
relevant field from the Fields pane. The selected field’s data type must be URL (specified in BI Catalog 
Builder). 

When multiple database records are found for the image URL, the following message will be displayed: 
“Single Record Required”. A down-arrow ( ) is available to select a single image URL by its position 
when sorted alphabetically (dictionary order). Options available include “None”, “Minimum”, and 
“Maximum”.

If no database record is found for the image, the default image URL, if provided, will be used instead. The 
default image URL is defined on the image visualization’s Format tab.

Part 2: Sort & Filter

For details about filtering the data used by an image, please refer to the previous subsection, Sort and 
Filter – Tab.
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Part 3: Format

Title

Title for image, which is displayed along its header.

Default Image URL

The file path for the default image URL. The default image URL will be displayed if no database record is 
found for the image visualization. Note, the URL to the image must be accessible. 

For example:

https://cmicglobal.com/wp-content/uploads/2018/06/ConstructionSoftwareEvolved_062218-1200x811.jpg

Fitting

Used to set how the image is displayed within the aspect ratio of the visualization. Options available are as 
follows:

Cover: Keep aspect ratio while filling the visualization. If the image’s aspect ratio does not match the 
aspect ratio of the visualization, then the image will be clipped to fit.

Contain: Keep aspect ratio while fitting within the visualization. The image will be “letterboxed” if its 
aspect ratio does not match the aspect ratio of the visualization.

Fill: Fill the entire visualization. If the image’s aspect ratio does not match the aspect ratio of the 
visualization, then the image will be stretched to fit.

None: The image is not resized. 

Width

Shows the width of the visualization (editable to allow the user to adjust width).

Height

Shows the height of the visualization (editable to allow the user to adjust height).

Show Border – Checkbox

Check to apply border to visualization.
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Drill in Place

Target Dashboard: Used to specify a Drill in Place target to a dashboard.

Target Visual: Used to specify a Drill in Place target to specific visual on a dashboard (when a target 
dashboard has been selected in the Target Dashboard field above).

Text

Example of Text Visualization
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Part 1: Plotting Fields

Value

This plotting field is used to set the text to be displayed in the visualization, which is a single non-
aggregated value from the database. To set the text, drag the relevant field from the Fields pane. All data 
types are supported. An alternate format for number and date can be specified on the text visualization’s 
Format tab.

When multiple database records are found, the following message will be displayed: “Single Record 
Required”. For String or URL data types, a down-arrow ( ) is available to select a single text value by its 
position when sorted alphabetically (dictionary order). Options available include “None”, “Minimum”, 
and “Maximum”.

If no database record is found, the following message will be displayed: “No data to display”.

Part 2: Sort & Filter

For details about filtering the data used by the text visualization, please refer to the previous subsection, Sort 
and Filter – Tab.
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Part 3: Format

Title

Text: Title for visualization, which is displayed along its header.

Callout Value

Format: Used to specify format of the value.

V. Align: Used to set the vertical alignment of the text. Options available are “Top”, “Middle”, or 
“Bottom”. When the number of characters exceeds the visualization’s available space, a vertical scrollbar 
is displayed. The scrollbar only appears when the V. Align property is set to “Top”. The text is clipped for 
all other V. Align options.

H. Align: Used to set the horizontal alignment of the text. Options available are “Left”, “Center”, or 
“Right”.

Size: Used to set the font size of the text.



User Reference BI Dashboard Builder - ADF Tool Visualizations  •  109

Weight: Used to set the font weight of the text. Options available are “Lighter”, “Normal”, and “Bold”.

Color: Used to set the color of the text using a pop-up color selector. 

Drill in Place

Drill-down Filter – Checkbox: Check to pass the current value to the target dashboard.

Target Dashboard: Used to specify a Drill in Place target to a dashboard.

Target Visual: Used to specify a Drill in Place target to specific visual on a dashboard (when a target 
dashboard has been selected in the Target Dashboard field above).

Other

Top, Left: In fixed layout, the location of the top-left corner for each visualization is displayed. This 
provides the ability to line visualizations up without using a mouse.

Width: Shows the width of the visualization (editable to allow the user to adjust width).

Height: Shows the height of the visualization (editable to allow the user to adjust height).

Show Border – Checkbox: Check to apply border to visualization.

Interact with Visualizations

Mouseovers

Hover mouse over any Series segment to view its details, as shown above.

Dynamically Scale Charts
Hover mouse over a chart and use mouse-wheel to zoom in to view smaller segments, and to zoom out.
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Dynamically Removing Series from Visualizations

Click a Series element in the Series Legend to remove it from the visualization, and click it again to re-add it.

Dynamically Control Displayed Data Using Page Filters

As shown above, page filters can be added to control the data displayed by a single visualization, or for all 
visualizations on a dashboard.

Page filters are added using the “Insert Filter” option under the Dashboard drop-down menu.
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Making Dashboards Accessible 
via Console
Add Dashboard Link to Treeview

To add a link to a dashboard in Treeview, please refer to the V10xTOOLS ADF - UI Treeview Builder reference 
guide in conjunction with the following instructions.

There are two ways to add a link to a Treeview once the menu item has been added. Both methods are described 
below.

Use Dashboard’s URL
On the UI Treeview Builder screen, add a new menu item to a Treeview and use the Item Properties section to 
set the Target Type field to “External URL”.
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Next, click on [Create a new Target]. 

In the Create/Edit Target pop-up window, enter the target’s name in the Name field and select “External URL” 
in the Type field. In the URL field enter the dashboard’s URL as provided by the Get Link option under the 
Dashboard drop-down menu in BI Dashboard Builder, as shown below.  
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Click on [Save] to close the Create/Edit Target pop-up window.

Finally, select the created target via the Target Name field in the Item Properties section of the UI Treeview 
Builder screen and click on [Save].

Create User-Defined Target 
On the UI Treeview Builder screen, add a new menu item to a Treeview and use the Item Properties section to 
set the Target Type field to “BI Dashboard”.
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Next, click on [Create a new Target]. 

In the Create/Edit Target pop-up window, enter the target’s name in the Name field and select “BI Dashboard” 
in the Type field. Use the BI Dashboard field’s LOV to select the dashboard you would like to add to the target. 
When finished, click on [Save].

Finally, select the created target via the Target Name field in the Item Properties section of the UI Treeview 
Builder screen and click on [Save].

Add Dashboard Tab to Console

To create a new tab on the UI Console to launch a dashboard, as shown above, please refer to the V10xTOOLS –
Console reference guide in conjunction with the following instructions.

With the UI Console in Edit mode, add a new tab, then edit the Region Content (as shown below) so that the 
Content Type field is set to “External URL”, the ‘External’ radio button is selected and the URL field is set to 
the dashboard’s URL:

To get the link to a dashboard, use BI Dashboard Builder’s Get Link option, as shown in the previous section.
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Making BI Queries Accessible via 
Console
Add BI Query Link to Treeview

For details on adding a link to a BI Query in Treeview, please refer to Step 6: Make Query Accessible via 
Console in the BI Query Builder – Quick Guide at the end of this guide.
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Setup
CMiC BI Security – BI Dashboard Builder

System Privileges

The following system privileges pertain to BI Dashboard Builder:

System Privilege Description

BIDBRDEDIT Allows user, BI Developer or BI Administrator, to create, edit and delete dashboards.

BISECMNG

Grants BI Administrators full security privileges for BI Catalog Builder, giving them 
access to all data sources in BI Catalog Builder in order to grant members of security 
roles access to data sources and their business areas and folders.

Note though, if Catalog Security was enabled in BI Catalog Builder, by using the 
Assign Roles context menu option, in BI Dashboard Builder they will only have 
access to data sources to which they have been granted access via BI Catalog Builder. 
Typically, though, admins would not need access to data sources in BI Dashboard 
Builder, only BI Developers would.

In BI Dashboard Builder, this privilege grants administrator’s access to the Assign 
Roles to Dashboards option to grant members of security roles access to dashboards. 
Note, this option is available without opening a dashboard.

NOTE: Depending on security setup, the administrator’s security role may also need 
to be assigned to the Assign Roles to Dashboards program. For more details, refer to 
Dashboard Security: Granting Access to Dashboards in the section below. 

Security Setup & Rules – Catalog & Dashboard Security
1. Catalog Security: Granting Access to Data Sources, Business Areas & Folders
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• If at least one security role is assigned to any data source, business area or folder in BI Catalog Builder, 
Catalog Security is enabled.

• Once Catalog Security is enabled, for each data source, business area and folder, only users belonging 
to the security role(s) assigned to them can use them.

• In BI Dashboard Builder, if a user has rights to a data source, but not all of its business areas and 
folders, the business areas and folders to which the user does not have rights are hidden from the 
user.

• If a user does not have rights to a data source, the data source and any dashboards using it are hidden 
from the user

• If Catalog Security is not enabled or used, Dashboard Security can be used to control user access to 
dashboards, as per the following about Dashboard Security.

2. Dashboard Security: Granting Access to Dashboards

I. Initial Security Setup

After BI Dashboard Builder is installed, security roles must be assigned to the provided 
dashboards to make them accessible to users.

II. Granting Access to Dashboards

To grant a user access to a dashboard, the security role to which the user belongs must be 
assigned to the dashboard. This can be done using the “Assign Roles to Dashboard” option under 
the Utilities menu of BI Dashboard Builder (shown below), by an administrator with the 
BISECMNG system privilege.

Depending on security setup, the administrator’s security role may also need to be assigned to the 
Assign Roles to Dashboards program using the Assign Roles to Programs screen in the System 
Data module, as shown in the screenshot below.



118 • Setup User Reference BI Dashboard Builder - ADF Tool

Pgm: FORMROLE – Assign Roles to Programs; standard Treeview path: System > Security > Roles > 
Assign Roles to Programs  

NOTE: A link to launch the Assign Roles to Dashboards utility can be added as a new Console 
Tab using the Console tool, or to a Treeview using the Treeview Builder tool. The Target for this 
utility, which is required by the tools to create a link to the utility, is “SD - Assign Roles to BI 
Dashboards”.

3. Set Up BI Developers

To set up a user as a BI Developer, an administrator with the BISECMNG system privilege needs to grant 
the developer the BIDBRDEDIT system privilege (allows user to create, edit and delete dashboards).

If Catalog Security is being used (set up in BI Catalog Builder), the BI Developer needs to be granted 
access to the data sources, business areas and folders required to create the dashboards they will be 
creating.

4. Dashboard Security for New Dashboards

When a BI Developer saves a new dashboard, the developer is asked to assign a security role to the 
dashboard. Only security roles to which the developer belongs can be assigned by the developer to the 
new dashboard.

To assign other security roles to new dashboards, administrators with the BISECMNG system privilege 
can use the “Assign Roles to Dashboard” option under the Utilities menu, as described in part 2 
(Dashboard Security) above.
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CMiC BI Security Setup – Quick 
Guide
Overview – CMiC BI Security

A standard CMiC Catalog and several Default Dashboards are provided with CMiC’s BI tools, but before you 
get started, you must set up your BI security. This quick guide leads you through the three easy steps to set up 
your BI Administrators, BI Developers and Dashboard End Users. Once your security is set up, CMiC’s BI 
tools are ready for you to use.

Happy building!

Setup Notes to Keep in Mind

BI Administrators

BI Administrators have full security privileges for BI Catalog Builder, meaning they have access to all 
data sources in BI Catalog Builder in order to grant members of security roles access to data sources and 
their business areas and folders.

NOTE: In BI Dashboard Builder, if Catalog Security was enabled, BI Admins will only have access to 
data sources to which they have been granted access via BI Catalog Builder. Typically, though, BI 
Admins would not need access to data sources - only BI Developers would.

In BI Dashboard Builder, BI Administrators can access the Assign Roles to Dashboards option, which is 
available without opening a dashboard, to assign security roles to dashboards.

BI Developers

By default, Catalog Security is not enabled, and the provided CMiC Catalog provides BI Developers 
access to data from all parts of the system.

If security access to data in the CMiC Catalog needs to be tailored for each BI Developer, BI Catalog 
Builder is required to enable and configure Catalog Security.

Also, if custom data sources are needed to create unique, client specific dashboards, BI Catalog Builder is 
required to develop and add them to the CMiC Catalog.

Dashboard End Users

By default, none of the provided dashboards are accessible to any user. Dashboard End Users, as well as 
BI Developers, can only see dashboards to which they have been granted access.

Step 1: BI Administrator Setup
A BI Administrator is someone that has security privileges for administering BI Dashboard Builder and BI 
Catalog Builder.
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System Privileges for BI Administrators
To set up a user as a BI Administrator, grant the user the following system privileges. For details about granting 
system privileges, please refer to the following section: Assigning System Privileges.

BISECMNG – System Privilege (Dashboard Builder & Catalog Builder)

Grants BI Administrators full security privileges for BI Catalog Builder, giving them access to all data 
sources in BI Catalog Builder in order to grant members of security roles access to data sources and their 
business areas and folders.

Note though, if Catalog Security was enabled in BI Catalog Builder, by using the “Assign Roles” context 
menu option, in BI Dashboard Builder they will only have access to data sources to which they have been 
granted access via BI Catalog Builder. Typically, though, admins would not need access to data sources in 
BI Dashboard Builder - only BI Developers would.

In BI Dashboard Builder, this privilege grants administrator’s access to the Assign Roles to Dashboards
option to grant members of security roles access to dashboards. Note, this option is available without 
opening a dashboard.

BIDBRDEDIT – System Privilege (Dashboard Builder)

Allows a BI Administrator or BI Developer to create, edit and delete dashboards.

BICTLGBLDR – System Privilege (Catalog Builder)

Allows a BI Administrator or BI Developer to access BI Catalog Builder.

Step 2: BI Developer Setup
A BI Developer is someone that creates dashboards, and if BI Catalog Builder is being used, they could also 
create the data sources used to create dashboards.

Part I: System Privileges for BI Developers
To set up a user as a BI Developer, grant the user the following system privileges. For details about granting 
system privileges, please refer to the following section: Assigning System Privileges – Quick Guide.

BICALCFLD – System Privilege (Catalog Builder)

Allows a BI Developer to create calculated fields and to modify their calculation in BI Catalog Builder.

BICFDRFLTR – System Privilege (Catalog Builder)

Allows a BI Developer to modify folder filters in BI Catalog Builder.

BICTLGBLDR – System Privilege (Catalog Builder)

Allows a BI Developer to access BI Catalog Builder.

BIDBRDEDIT – System Privilege (Dashboard Builder)

Allows a BI Administrator or BI Developer to create, edit and delete dashboards.

BIUDFSETUP – System Privilege (Catalog Builder)

Allows BI Developer to modify the Base Object Name property of User Defined Fields in folders, in BI 
Catalog Builder.
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BIMODJOINS – System Privilege (Catalog Builder)

Allows a BI Developer to modify folder joins in BI Catalog Builder.

Part II: Catalog Security for BI Developers (Catalog Builder – Data 
Source Security)

NOTE: For CMiC Cloud users, BI Catalog Builder is an advanced, premium tool. For details, please contact 
your CMiC Account Representative.

If BI Catalog Builder is being used, and Catalog Security is to be enabled, a BI Administrator uses the “Assign 
Roles” context menu option (shown above) on the Edit Data Source screen of BI Catalog Builder to grant 
members of security roles access to data sources and their business areas and folders. 

In BI Dashboard Builder, if a BI Developer has rights to a data source, but not all of its business areas and 
folders, the business areas and folders to which the developer does not have rights are hidden from the 
developer. If a developer does not have rights to a data source, the data source and any dashboards using it are 
hidden from the developer.

NOTE: The “Assign Roles” context menu option is not available for the CMiC Default Data Source’s business 
areas and folders.
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Step 3: Dashboard End User Setup

Utilities drop-down menu

A Dashboard End User is someone that uses dashboards, such as an AP clerk.

Assign Roles to Dashboards – Dashboard Security
To grant a Dashboard End User access to a dashboard, the security role to which the user belongs must be 
assigned to the dashboard. This is done using the “Assign Roles to Dashboard” option under the Utilities menu 
of Dashboard Builder (shown above), by a BI Administrator (user with BISECMNG system privilege).

NOTE: A link to launch the Assign Roles to Dashboards utility can be added as a new Console tab using the 
Console tool, or to a Treeview using the Treeview Builder tool. The Target for this utility, which is required by 
the tools to create a link to the utility, is “SD - Assign Roles to BI Dashboards”.

Step 4: Data Security Setup

Defining and Applying Data Security Within a BI Dashboard
BI Dashboard Builder allows security to be applied right down to a detailed data level so that dashboard and 
query views can be restricted to display only those records to which the user has access. 

This detailed level of security is beneficial, for example, if records are being displayed from a folder, for 
example from a PM Issues folder, and data should be limited to display only those records from projects to 
which the user has access.

In this example, the following folders would be used:

• PM Issues Folder: Returns data for all projects regardless of user’s security.

• PM Projects Folder: Returns only those projects to which the user has access.

To enforce PM Projects security on PM Issues data when building a dashboard or query, the PM Projects folder 
must be added to the list of selected fields and the ‘Use All Folders’ option must be checked. (For more 
information on this option, refer to the Use All Folders section in this guide).  

CMiC BI Training
If you would like to schedule a CMiC BI training session, please contact CMiC Support, and they will ensure 
that you are scheduled for training as quickly as possible.



User Reference BI Dashboard Builder - ADF Tool Assigning System Privileges – Quick Guide  •  123

Assigning System Privileges –
Quick Guide
Option 1: Assign System Privilege to Security Role

Pgm: ROLES – Roles; standard Treeview path: System > Security > Roles > Define Roles

Using the Security Roles screen in the System Data module, select the role to which the system privileges will 
be added and click [System Privileges].



124 • Assigning System Privileges – Quick Guide User Reference BI Dashboard Builder - ADF Tool

In the pop-up, shown below, check the ‘Select’ checkbox for the privileges to grant the role and click [Close]:

Back on the main screen, click [Save].

Option 2: Assign System Privilege to User ID

Pgm: SDUSRMNT – User Maintenance; standard Treeview path: System > Security > Users > User Maintenance

In the User Maintenance screen, load the target user and click the System Privileges tab. Then, use the ‘Select’
checkboxes to select the system privileges to grant the user and click [Save/Refresh].
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BI Query Builder – Quick Guide
Overview – BI Query Builder

BI Query Builder

BI Dashboard Builder is a powerful business intelligence tool for building custom dashboards with interactive 
charts, gauges, and tables that use real-time data directly from your CMiC system.  

BI Query Builder, however, is a simplified version of BI Dashboard Builder, tailored specifically for building 
and generating queries. In this specialized version of the software, users can focus on creating and modifying 
queries. In BI Query Builder, a query is a dashboard that contains a single table visualization that is always 
maximized. This fine-tuned query generator makes query building simple and easy, and it supports all the table 
visualization features available in BI Dashboard Builder, including pivoting, drill-in-place, etc. In addition, 
queries built in BI Query Builder can be viewed and maintained in BI Dashboard Builder. 

This quick guide focuses on the components and functionality specific to the BI Query Builder tool. For more 
information on the full-blown software features of BI Dashboard Builder, including requirements and setup 
options, please refer to the BI Dashboard Builder guide.
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Getting Started – Creating Queries

Step 1: CMiC BI Security Setup
Before Query Builder can be used, CMiC BI security must be set up. Please refer to the following sections in 
the BI Dashboard Builder guide:

• CMiC BI Security Set Up – Quick Guide

• CMiC BI Security – BI Dashboard Builder

Step 2: Create New Query

Click the File drop-down menu and select “New”. 

In the pop-up, shown below, provide a name for the new query and select the data source containing the folders 
(tables/views) required to create the query’s table visualization.

Upon clicking [OK], the newly created query is displayed:
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Since the screen will initially be in edit mode when a new query is being created, the Visualization Properties 
and Field panes will be visible, as shown above.

When a user creates a new query, the query’s name defaults as the title of the query on the dashboard.

Step 3: Add Fields to Query

Click the up-arrow ( ) in the Fields pane to add fields (tables/views) to the query (table visualization).
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Step 4: Configure Query’s Properties

Example of Query

Configure the query’s properties using the Visualization Properties control, as shown above. 

Card View Properties
The Card View properties are located on the Plotting Fields tab and the Format tab, as shown below. They are 
used for customizing settings if the user will be launching their query in card view.

Plotting Fields Tab
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Line Label: This property is used to specify how the column’s line label appears on the card. For 
example: 

If this property is left empty, the card defaults the column’s title. In this example, it’s the Account 
column so it would appear in card view as follows:

If a label is specified, such as “ACCT:”, then it would appear in card view as follows:

No Label – Checkbox: Check this box to display no label. 

For example, if the ‘No Label’ checkbox is checked for the Account column, it would appear in 
card view as follows:

Read-only – Checkbox: Checking this box enables a read-only setting for the table column. This setting 
has the highest priority. It ensures that the column is not updatable and overrides the updatable setting in 
BI Catalog Builder. This setting can only be modified in BI Query Builder/BI Dashboard Builder and is 
disabled at runtime.
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Show Total – Checkbox: Checking this box enables the Total Label and Calculate properties. A new 
totals card titled “Bucket Value Totals” will be added in card view. 

This example shows a Bucket Value Totals card entered for the Opening Balance column.
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The next example shows a Bucket Value totals card entered for the following three columns: 
Account, Department, and Opening Balance.

Total Label: This property is enabled when the ‘Show Total’ box is checked. It allows the user to add a 
label to the column’s title in the Bucket Value Totals in card view.

Calculate: This property is enabled when the ‘Show Total’ box is checked. It allows the user to specify 
the type of calculation performed on each column’s bucket value totals (e.g. Average, Count, Count 
(Distinct), Maximum, Median, Population Standard Deviation, Sample Standard Deviation, or Sum). 

Format Tab

Launch as Card View – Checkbox: Allows the user to set the query to launch in card view by default and 
turns the query type from “Query” to “Card”, allowing it to be filtered as card view in BI Analytics.
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Lines Per Card: Allows the user to set the number of lines per card. By default, the lines per card is three.
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Step 5: Save and Assign Security Role(s) to Query

Click on File and select “Save” from the drop-down menu.

A pop-up window will appear to assign a security role to the query. Select a security role and click on [Save].

NOTE: Queries are only available to users that belong to the assigned security roles. 

Step 6: Make Query Accessible via Console
Lastly, the new query needs to be made accessible to end-users. 

Add BI Query Link to Treeview
To add a link to a BI Query in Treeview, please refer to the V10xTOOLS ADF - UI Treeview Builder reference 
guide in conjunction with the following instructions.



134 • BI Query Builder – Quick Guide User Reference BI Dashboard Builder - ADF Tool

Create User-Defined Target

On the UI Treeview Builder screen, add a new menu item to a Treeview and use the Item Properties
section to set the Target Type field to “BI Query”.

Next, click on [Create a new Target].

In the Create/Edit Target pop-up window, enter the target’s name in the Name field and select “BI Query” 
in the Type field. Use the BI Query field’s LOV to select the query to be added to the target. When 
finished, click on [Save].

Finally, select the created target via the Target Name field in the Item Properties section of the UI 
Treeview Builder screen and click on [Save].
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Query Builder Toolbar

Toolbar – Controls

Query Builder with toolbar controls framed in red

The following toolbar controls are available in BI Query Builder.

Query By Example

A filter icon is available to Query by Example (QBE).

When the filter icon is clicked, a row of fields appears above the table column headers for the user to enter QBE 
expressions for each of the table’s columns. 

For more details on comparison and logical operators available to use in the expression fields for String, 
Number and Date columns, refer to the Query By Example (QBE) section in the BI Dashboard Builder guide.

Sort Ascending 
This option aligns the table’s sort order to the order of the columns and sorts the table’s columns in ascending 
order. 
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For more details, refer to the Sort Ascending section in the BI Dashboard Builder guide.

Sort Descending 
This option aligns the table’s sort order to the order of the columns and sorts the table’s columns in descending 
order.

For more details, refer to the Sort Descending section in the BI Dashboard Builder guide.

Show/Hide Visualization Settings

This option is used to show/hide the query’s visualization settings.

Export to Excel 
An Excel icon is available to export the query to an Excel spreadsheet.

For more details, refer to Export Table to Excel section in the BI Dashboard Builder guide.

Export to PDF 
A PDF icon is available to export the query to a PDF file.
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For more details, refer to Export Table to PDF section in the BI Dashboard Builder guide.

Card View 

The Card View icon ( ) is available to launch a query in card view. (This icon is not visible for IE version 11 
or lower.) From card view, the Table View icon ( ) can be used to toggle back to table view. 

Within the Card View screen, the user can specify how many lines to appear in each card. Each card line 
represents a column in the query table. The order of the lines from top to bottom correspond to the order of the 
columns from left to right in the table. 

In addition, each pivot item along the top of the screen allows filtering. Clicking on a pivot item in card view 
allows the user to display buckets by pivot item. If the user would like to add new pivot items, they must add 
the pivot items in table view and then they will be displayed in card view as well.
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Clicking on a card launches the Card Details pop-up window, which contains additional details contained within 
the card.

Cards can be dragged and dropped if the following conditions are met:

• All aggregatable columns’ aggregation must be set to “None”.

• The selected pivot item:

o Must be a User Defined Field (UDF) and updatable. This is specified in BI Catalog 
Builder.

o Its primary key values must be unique for each row on the table in Table View.
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Refresh 

This control is used to refresh a query’s table visualization using current data from the database.

Menu 

An Ellipses icon is available to open a drop-down menu containing additional query options. The options 
contained in this menu are described below.

Edit Query

When a query is launched via URL, this option will allow users to open this query in BI Query Builder if 
they have the appropriate system privilege (BIDBRDEDIT) assigned. BI Query Builder will be launched 
in a separate tab and this query will be automatically opened for editing.

Query Settings

The Query Settings pop-up window launched from this menu option contains the ‘Current Project Only’ 
checkbox. If this box is checked, and the query’s table visualization is using folders that are current-
project sensitive, the table will only use data from the user’s current default project, as set in CMiC Field.
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Get Link…

The Get Link pop-up window launched from this menu option displays the URL for the query, which can 
be right-clicked and copied using the context menu that appears.

Replace…

This option allows a table visualization to be replaced with a copy/reference table visualization from 
another query. Users can create a table visualization in one query and place it in other queries as a copy or 
reference visualization. A visualization can be copied/referenced multiple times. 

Enable Text Selection

If checked, this menu option allows the user to select table cell text when drill-in-place is enabled.

Create User-Defined Log…

This feature is used to create a user-defined log in CMiC Field based on a table visualization.

For more information, refer to the Create User-Defined Log based on Table section in the BI Dashboard 
Builder guide.

Group Sorts

This option contains two sub-options: 

• Remove Group Sorts (Keep Subtotals): This option is used to remove all Group Sorts set up for 
the table but to keep Subtotals for Group Sorts.

• Remove All Group Sorts: This option is used to remove all Group Sorts (including Subtotals for 
Group Sorts) set up for the table. 

The Group Sort option for tables is discussed in more detail in Part 1: Plotting Fields section in the BI 
Dashboard Builder guide.

About

The pop-up window launched from this menu option provides additional details about the selected 
visualization.
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BI Query Builder – Screen

File – Menu

File drop-down menu

New – Menu Option

Launches the above New Query pop-up with the following fields to fill out:

Field Details
Name Name for new query, which auto-populates ID field.

ID
Identifier used by system to identify new query, which is auto-populated based 
on Name field; can use uppercase alphanumeric characters and underscore 
character, but spaces are not allowed.

Data Source
Contains the folders (i.e., tables/views) to use to create the query’s table 
visualization. Table visualizations can either use data from a single folder, or 
data returned by joined folders. 

After clicking [OK], the new query is loaded and ready to have a table visualization added.
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Open – Menu Option

This option launches the above Search and Open Query pop-up to search for and select a query to open.

NOTE: When BI Query Builder is accessed for the first time, none of the provided default queries will be 
available to any user, until they are granted appropriate security access. 

Use the Data Source, Name and/or ID search fields to find a particular query, and note that the following 
wildcard characters can be used:

• % (any string of characters)

• _ (any single character)
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Use the [Advanced] button to switch the pop-up to Advanced Search mode, shown below:

In Advanced Search mode matching operators can be used, search fields can be added, and search fields can be 
reset and reordered.

Export – Menu Option

The Export and Import functionality is used to copy queries from one Enterprise environment to another. For 
instance, if queries are created in the Test/Development environment, they can be copied to the Production
environment using this functionality. 

Import – Menu Option

This option is used along with the Export option to copy queries from one Enterprise environment to another. 

Save – Menu Option

Saves changes to query.

NOTE: The user will be unable to save a query if errors exist (missing fields, missing folder, etc.) and will be 
required to resolve these errors before the query will save. This functionality prevents broken visualizations 
from becoming corrupted to the point that they become unrecoverable.
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Save As – Menu Option

Opens the Save As pop-up window, which can be used to create a copy of the current query by saving it with a 
different name.

Delete – Menu Option

This option launches the above Search and Delete Query pop-up window to search for and delete a query.

Use the Data Source, Name and/or ID search fields to find a particular query, and note that the following 
wildcard characters can be used:

• % (any string of characters)

• _ (any single character)

Use the [Advanced] button to switch the pop-up to Advanced Search mode, where matching operators can be 
used, and search fields can be added or reordered. 

About – Menu Option

This option is used to display information about the application and its server.
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Query – Menu

Query drop-down menu

Rename – Menu Option

This option launches the above Rename pop-up window used to rename the query.

Get Link – Menu Option

This option launches a pop-up window which displays the URL for the query, which can be right-clicked and 
copied using the context menu that appears.

Discard Changes – Menu Option

This option launches a pop-up window which prompts the user to confirm the discarding of all unsaved 
changes. Click [OK] to revert the query back to the way it was before the unsaved changes. 

Delete – Menu Option

This option launches a pop-up which prompts the user to confirm the deletion of current query. Click [OK] to 
permanently delete it.
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Preferences – Menu

Preferences drop-down menu

Autoload Data – Menu Option

The Autoload Data checkbox is intended for query developers, to allow them to build queries faster, without 
waiting for data to load while building. This checkbox is a user setting of the Query Builder tool and is not an 
attribute of a query. The checkbox will stay checked or unchecked for each user (as it’s the user’s setting) and 
will apply to all queries (as it’s the tool’s setting).

When launching a query via URL, the data will always be loaded.

NOTE: An option does not exist to turn autoload data on or off when a query is launched via URL. 

By default, this checkbox is checked for the user.

If checked, when a query is loaded, data is automatically loaded for the table visualization. Otherwise, when a 
query is loaded, the table visualization will not be loaded with data, and to do so requires clicking the Refresh 
icon . This is handy when building a query, and you wish for it to load quickly.

Utilities – Menu

Utilities drop-down menu
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Assign Roles to Query – Query Security

Assigning security roles to queries

To grant a user access to a query, the security role to which the user belongs must be assigned to the query. This 
can be done using the “Assign Roles to Query” option under the Utilities menu of BI Query Builder (shown 
above), by an administrator with the system privilege BISECMNG. This option is available without opening a 
query. Depending on security setup, the administrator’s security role may also need to be assigned to the Assign 
Roles to Query program using the Assign Roles to Programs screen in the System Data module, as shown in the 
screenshot below.

Pgm: FORMROLE – Assign Roles to Programs; standard Treeview path: System > Security > Roles > Assign Roles to 
Programs  
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[Reading View] – Button

If the [Reading View] button is visible, the screen is in Edit Query mode, as shown above, and the 
Visualization Properties and Fields panes are available to create and edit queries.

Click the [Reading View] button to switch the screen to Reading View mode, which displays the query as it 
would be displayed to end-users, for review and testing purposes.

[Editing View] – Button

If the [Edit Query] button is visible, the screen is in Reading View mode, as shown above, and the 
Visualization Properties and Fields panes are not available. In Reading View mode, the query is displayed as it 
would be to end-users for review and testing purposes.

Click the [Edit Query] button to switch the screen to Edit Query mode, which is used to create and edit queries.



User Reference BI Dashboard Builder - ADF Tool Index  •  149

Index

[

[Editing View] - Button...........................................................................................................................................................35, 148
[Reading View] - Button .........................................................................................................................................................35, 148

A

About ............................................................................................................................................................................................ 57
About - Menu Option..................................................................................................................................................................... 20
Add BI Query Link to Treeview................................................................................................................................................... 115
Add Dashboard Link to Treeview................................................................................................................................................. 111
Add Dashboard Tab to Console .................................................................................................................................................... 114
Add, Edit, Delete, Reposition ......................................................................................................................................................... 49
Assign Roles to Dashboards - Dashboard Security ...................................................................................................................34, 122
Assigning System Privileges - Quick Guide .................................................................................................................................. 123
Autoload Data................................................................................................................................................................................ 33

B

BI Dashboard Builder - ADF Tool.................................................................................................................................................... 1
BI Dashboard Builder - Screen ....................................................................................................................................................... 16
BI Query Builder ............................................................................................................................................................................. 3
BI Query Builder - Quick Guide................................................................................................................................................... 125
BI Query Builder - Screen............................................................................................................................................................ 141
BI Springboards............................................................................................................................................................................... 2

C

Calculated (Custom) Fields ............................................................................................................................................................ 99
Charts: Bar, Column, Line & Area.................................................................................................................................................. 57
CMiC BI Security - BI Dashboard Builder.................................................................................................................................... 116
CMiC BI Security Setup - Quick Guide ........................................................................................................................................ 119
CMiC BI Solution Options ............................................................................................................................................................... 3
CMiC BI Training........................................................................................................................................................................ 122
CMiC Default Data Source & BI Catalog Builder ............................................................................................................................. 5
Create BI Springboards .................................................................................................................................................................. 98
Create User-Defined Log ............................................................................................................................................................... 56
Create User-Defined Log based on Table........................................................................................................................................ 92



150 • Index User Reference BI Dashboard Builder - ADF Tool

D

Dashboard - Menu ......................................................................................................................................................................... 21
Dashboard Runtime Controls.......................................................................................................................................................... 11
Data Sources.................................................................................................................................................................................... 4
Data Sources, Business Areas, Folders, & Fields............................................................................................................................... 4
Date Fields .................................................................................................................................................................................. 100
Defining and Applying Data Security Within a BI Dashboard........................................................................................................ 122
Delete - Menu Option............................................................................................................................................................... 20, 33
Discard Changes - Menu Option..................................................................................................................................................... 33
Drill in Place.................................................................................................................................................................................. 51
Duplicate....................................................................................................................................................................................... 54
Dynamically Control Displayed Data Using Page Filters............................................................................................................... 110
Dynamically Removing Series from Visualizations....................................................................................................................... 110
Dynamically Scale Charts ............................................................................................................................................................ 109

E

Edit, Show/Hide Properties, Refresh - Controls............................................................................................................................... 11
Editing Data Sources, Business Areas, Folders and Fields in Catalog Builder................................................................................... 46
Export - Menu Option .................................................................................................................................................................... 18
Export Table to Excel..................................................................................................................................................................... 90
Export Table to PDF ...................................................................................................................................................................... 86

F

Fields - Pane.................................................................................................................................................................................. 42
File - Menu.............................................................................................................................................................................16, 141
Format - Tab.................................................................................................................................................................................. 41

G

Gauges .......................................................................................................................................................................................... 63
Get Link ........................................................................................................................................................................................ 53
Get Link - Menu Option................................................................................................................................................................. 32
Getting Started - Creating Dashboards .............................................................................................................................................. 6
Getting Started - Creating Queries ................................................................................................................................................ 126
Group Sorts ................................................................................................................................................................................... 56

I

Images......................................................................................................................................................................................... 103
Import - Menu Option .................................................................................................................................................................... 19
Insert Filter (Page Filter) - Menu Option......................................................................................................................................... 22
Insert Line Break - Menu Option .................................................................................................................................................... 25
Insert Substitution Variable - Menu Option..................................................................................................................................... 26
Interact with Visualizations .......................................................................................................................................................... 109

J

Join Tree ....................................................................................................................................................................................... 44



User Reference BI Dashboard Builder - ADF Tool Index  •  151

L

Layout - Menu Option.................................................................................................................................................................... 21

M

Making BI Queries Accessible via Console................................................................................................................................... 115
Making Dashboards Accessible via Console ................................................................................................................................. 111
Maximize and Restore.................................................................................................................................................................... 50
Mouseovers ................................................................................................................................................................................. 109

N

New - Menu Option ....................................................................................................................................................................... 16

O

Open - Menu Option ...................................................................................................................................................................... 17
Option 1: Assign System Privilege to Security Role ...................................................................................................................... 123
Option 2: Assign System Privilege to User ID............................................................................................................................... 124
Overview - BI Dashboard Builder..................................................................................................................................................... 1
Overview - BI Query Builder ....................................................................................................................................................... 125
Overview - CMiC BI Security ...................................................................................................................................................... 119

P

Part 1: Plotting Fields..................................................................................................................................... 57, 60, 63, 67, 104, 107
Part 2: Sort & Filter........................................................................................................................................ 58, 60, 64, 77, 104, 107
Part 3: Format................................................................................................................................................ 58, 61, 65, 78, 105, 108
Part I: System Privileges for BI Developers .................................................................................................................................. 120
Part II: Catalog Security for BI Developers (Catalog Builder - Data Source Security)..................................................................... 121
Pie Charts ...................................................................................................................................................................................... 60
Plotting Fields - Tab....................................................................................................................................................................... 37
Preferences - Menu .................................................................................................................................................................33, 146

Q

Query - Menu .............................................................................................................................................................................. 145
Query Builder Toolbar ................................................................................................................................................................. 135
Query By Example (QBE).............................................................................................................................................................. 84

R

Refresh.......................................................................................................................................................................................... 53
Remove ......................................................................................................................................................................................... 54
Remove All Group Sorts ................................................................................................................................................................ 96
Remove Group Sorts (Keep Subtotals)............................................................................................................................................ 95
Removing Fields............................................................................................................................................................................ 45
Rename - Menu Option.................................................................................................................................................................. 21
Replace ......................................................................................................................................................................................... 55
Requirements................................................................................................................................................................................... 3
Reset Position of Visuals - Menu Option......................................................................................................................................... 32



152 • Index User Reference BI Dashboard Builder - ADF Tool

S

Save - Menu Option....................................................................................................................................................................... 19
Save As - Menu Option.................................................................................................................................................................. 19
Security Setup & Rules - Catalog & Dashboard Security............................................................................................................... 116
Setup........................................................................................................................................................................................... 116
Sort and Filter - Tab....................................................................................................................................................................... 38
Sort Ascending ........................................................................................................................................................................ 56, 96
Sort Descending....................................................................................................................................................................... 56, 97
Step 1: BI Administrator Setup..................................................................................................................................................... 119
Step 1: CMiC BI Security Set Up ..................................................................................................................................................... 6
Step 1: CMiC BI Security Setup ................................................................................................................................................... 126
Step 2: BI Developer Setup .......................................................................................................................................................... 120
Step 2: Create New Dashboard ......................................................................................................................................................... 7
Step 2: Create New Query............................................................................................................................................................ 126
Step 3: Add a Visualization .............................................................................................................................................................. 8
Step 3: Add Fields to Query ......................................................................................................................................................... 127
Step 3: Dashboard End User Setup ............................................................................................................................................... 122
Step 4: Add Fields to Visualization................................................................................................................................................... 9
Step 4: Configure Query's Properties ............................................................................................................................................ 128
Step 4: Data Security Setup .......................................................................................................................................................... 122
Step 5: Configure Visualization Properties........................................................................................................................................ 9
Step 5: Save and Assign Security Role(s) to Query........................................................................................................................ 133
Step 6 (Optional): Add Page Filter for Visualization(s)...................................................................................................................... 9
Step 6: Make Query Accessible via Console ................................................................................................................................. 133
Step 7: Assign Security Role(s) to Dashboard ................................................................................................................................. 10
Step 8: Make Dashboard Accessible via Console ............................................................................................................................ 10
System Privileges......................................................................................................................................................................... 116
System Privileges for BI Administrators ....................................................................................................................................... 120

T

Tables............................................................................................................................................................................................ 67
Tables at Runtime.......................................................................................................................................................................... 82
Text............................................................................................................................................................................................. 106
Toolbar - Controls........................................................................................................................................................................ 135

U

Use All Folders.............................................................................................................................................................................. 47
Utilities - Menu.......................................................................................................................................................................34, 146

V

Visualization Menu........................................................................................................................................................................ 53
Visualization Properties - Control................................................................................................................................................... 37
Visualizations ................................................................................................................................................................................ 49
Visualizations - Pane...................................................................................................................................................................... 36
Visualizations Selector - Control .................................................................................................................................................... 36


	BI Dashboard Builder Œ ADF Tool 

	Overview Œ BI Dashboard Builder

	BI Springboards

	BI Query Builder 


	Requirements

	CMiC BI Solution Options


	Data Sources

	Data Sources, Business Areas, Folders, & Fields

	CMiC Default Data Source & BI Catalog Builder


	Getting Started Œ Creating Dashboards

	Step 1: CMiC BI Security Set Up

	Step 2: Create New Dashboard

	Step 3: Add a Visualization

	Step 4: Add Fields to Visualization

	Step 5: Configure Visualization Properties

	Step 6 (Optional): Add Page Filter for Visualization(s)

	Step 7: Assign Security Role(s) to Dashboard

	Step 8: Make Dashboard Accessible via Console


	Dashboard Runtime Controls 

	Edit, Show/Hide Properties, Refresh Œ Controls


	BI Dashboard Builder Œ Screen

	File Œ Menu

	New Œ Menu Option

	Open Œ Menu Option

	Export Œ Menu Option

	Import Œ Menu Option

	Save Œ Menu Option

	Save As Œ Menu Option

	Delete Œ Menu Option

	About Œ Menu Option


	Dashboard Œ Menu

	Rename Œ Menu Option

	Layout Œ Menu Option

	Insert Filter (Page Filter) Œ Menu Option

	Insert Line Break Œ Menu Option

	Insert Substitution Variable Œ Menu Option

	Reset Position of Visuals Œ Menu Option

	Get Link Œ Menu Option

	Discard Changes Œ Menu Option

	Delete Œ Menu Option


	Preferences Œ Menu

	Autoload Data


	Utilities Œ Menu

	Assign Roles to Dashboards Œ Dashboard Security


	[Reading View] Œ Button

	[Editing View] Œ Button

	Visualizations Œ Pane

	Visualizations Selector Œ Control

	Visualization Properties Œ Control


	Fields Œ Pane

	Join Tree

	Removing Fields 

	Editing Data Sources, Business Areas, Folders and Fields in Catalog Builder

	Use All Folders



	Visualizations

	Add, Edit, Delete, Reposition

	Maximize and Restore

	Drill in Place

	Visualization Menu

	Refresh

	Get Link

	Remove

	Duplicate

	Replace

	Create User-Defined Log

	Group Sorts

	Sort Ascending

	Sort Descending

	About


	Charts: Bar, Column, Line & Area

	Part 1: Plotting Fields

	Part 2: Sort & Filter

	Part 3: Format


	Pie Charts

	Part 1: Plotting Fields

	Part 2: Sort & Filter

	Part 3: Format


	Gauges

	Part 1: Plotting Fields

	Part 2: Sort & Filter

	Part 3: Format


	Tables

	Part 1: Plotting Fields

	Part 2: Sort & Filter

	Part 3: Format

	Tables at Runtime

	Query By Example (QBE)

	Export Table to PDF

	Export Table to Excel

	Create User-Defined Log based on Table 

	Remove Group Sorts (Keep Subtotals)

	Remove All Group Sorts

	Sort Ascending

	Sort Descending

	Create BI Springboards

	Calculated (Custom) Fields

	Date Fields


	Images

	Part 1: Plotting Fields

	Part 2: Sort & Filter

	Part 3: Format


	Text

	Part 1: Plotting Fields

	Part 2: Sort & Filter

	Part 3: Format


	Interact with Visualizations

	Mouseovers

	Dynamically Scale Charts

	Dynamically Removing Series from Visualizations

	Dynamically Control Displayed Data Using Page Filters



	Making Dashboards Accessible via Console

	Add Dashboard Link to Treeview

	Add Dashboard Tab to Console


	Making BI Queries Accessible via Console

	Add BI Query Link to Treeview


	Setup

	CMiC BI Security Œ BI Dashboard Builder

	System Privileges

	Security Setup & Rules Œ Catalog & Dashboard Security



	CMiC BI Security Setup Œ Quick Guide

	Overview Œ CMiC BI Security

	Step 1: BI Administrator Setup

	System Privileges for BI Administrators


	Step 2: BI Developer Setup

	Part I: System Privileges for BI Developers 

	Part II: Catalog Security for BI Developers (Catalog Builder Œ Data Source Security)


	Step 3: Dashboard End User Setup

	Assign Roles to Dashboards Œ Dashboard Security


	Step 4: Data Security Setup

	Defining and Applying Data Security Within a BI Dashboard 


	CMiC BI Training


	Assigning System Privileges Œ Quick Guide

	Option 1: Assign System Privilege to Security Role

	Option 2: Assign System Privilege to User ID


	BI Query Builder Œ Quick Guide 

	Overview Œ BI Query Builder

	Getting Started Œ Creating Queries

	Step 1: CMiC BI Security Setup

	Step 2: Create New Query

	Step 3: Add Fields to Query 

	Step 4: Configure Query™s Properties

	Step 5: Save and Assign Security Role(s) to Query

	Step 6: Make Query Accessible via Console


	Query Builder Toolbar 

	Toolbar Œ Controls


	BI Query Builder Œ Screen

	File Œ Menu

	Query Œ Menu

	Preferences Œ Menu

	Utilities Œ Menu

	[Reading View] Œ Button

	[Editing View] Œ Button



	Index




